
What is Dashboard 95?
{button ,AL(`INTRO')} See also

Dashboard 95: the key to driving Windows 95!
Welcome to Dashboard, the high powered, convenient utility that speeds up all your work with 
Windows 95. Dashboard gives you convenient push-button control over everything you do in 
Windows.
Dashboard is an onscreen set of buttons, icons, and dials for working with Windows quickly. You
can launch programs from Dashboard with just the click of a button or a keystroke or two, or you
can print or fax a file by simply dragging it to a Dashboard icon.
A set of miniature screens shows which programs you're working with; you can switch back and 
forth among them with a single click. Glancing at a panel, you can instantly check how much 
memory is left in your computer. Dashboard even has an alarm clock with a built-in snooze 
alarm. 
And one more thing: you can customise Dashboard to fit your personal style. It doesn't matter 
whether you prefer a “luxury sedan” or a “sports car,” Dashboard will run the way you want.



What's new in Dashboard 95?
{button ,AL(`INTRO')} See also

Dashboard 95 contains new and improved features that will make your work in Windows faster 
and easier. Here are some of the highlights:

Dashboard 95 is specifically designed to run in Windows 95 and to take advantage of its 
features.

You can organise Quick Launch buttons into the new Quick Launch groups.
Dashboard creates three system groups to give you instant access to your desktop, 

documents and Dashboard layouts. In addition, when you run Dashboard for the first time, the 
App Organizer scans your hard disk for common applications and creates groups and Quick 
Launch buttons for them. If you add applications later, the App Organizer finds them and adds 
them to the right groups.

You can dock the Quick Launch panel to any edge of your screen.
Layouts, which are arrangements of open programs in the Extended Screens, are now on 

the Quick Launch panel, so you can start several programs with a mouse click.
Dashboard 95 provides single-click access to some of the most frequently used Windows 

95 features, such as Find and the Explorer.
The enhanced Resources panel monitors Windows 95 system resources, including CPU 

usage, threads in use, and number of “virtual machines.” The CPU activity meter shows you the 
heartbeat of your computer.

You can tile or cascade windows on the desktop with one click.
The transition to Windows 95 is easier, because the Dashboard Programs panel preserves 

your Windows 3.1 program groups and provides single-click access to them.
The Dashboard Taskbar provides enhanced flexibility compared to the Windows 95 

taskbar. Dashboard's Taskbar can “float” in your workspace, and it can provide information about
each task at the click of a button.



Where to get help
{button ,AL(`INTRO')} See also

Your first source of help and information should be the manual and this online Help system. In 
addition, Starfish provides other support options.
The Starfish BBS
Download the Technical Information notes you need, 24 hours a day.

408-461-5930
Free online information services
Discuss your questions and problems with other users and Starfish experts.

On CompuServe, Go Starfish
On America Online, use the keyword Starfish
On Microsoft Network, the Go word is Starfish

Be sure to visit our Web site for product updates, companions and news (no technical support).
http://www.starfishsoftware.com

Free up and running support
No-charge assistance for installation and initial configuration.
        0141 946 0222 9.00 a.m. - 5.00 p.m. G.M.T.
Support hotline 
All the help you need, at £1.50 per minute including VAT:

0897 161 179, billed to your phone bill
9.00 a.m. - 5.00 p.m. G.M.T.
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Panels
{button ,AL(`WHATS_ON')} See also
Panels are groups of the most common features.
Dashboard groups most controls into panels that you have complete control over:

You can snap panels on and off the Dashboard for easier access.
You can control the size of panels, and even hide them if you want.
You can rearrange items on each panel, and rearrange panels on the Dashboard itself.



Menus
{button ,AL(`WHATS_ON')} See also
Menus are pull-down lists of commands you can use.
Dashboard provides three menus to help you work in the Windows environment:

Access typical Windows functions with the System menu.
Use the Task menu to switch between open programs, display the Dashboard Run dialog box, or close all 

programs other than Dashboard and the Program Manager.
Use the Layout menu to save your Dashboard screen layout

the placement and size of applications in the Extended Screens
and to manage other previously saved layouts.



Buttons
{button ,AL(`WHATS_ON')} See also
Buttons are icons you click to control Dashboard.
Buttons let you snap Dashboard panels on and off, launch Dashboard Run and Help, and open the Customise dialog 
box.



Shortcut menus
{button ,AL(`WHATS_ON')} See also
A panel's shortcut menu is usually the fastest way to work with Dashboard. You can right-click any panel to open its 
shortcut menu.
Each choice in a shortcut menu is a command that is also available elsewhere in Dashboard.
For example, to hide a tab in the Programs panel, you can either right-click the panel and choose Hide Group from 
the shortcut menu, or you can click the Customise button, select Programs from the Item to Customise list, select 
your program group from a list, click the Hide Group button, and click Done.



Rearranging panels
{button ,AL(`TASKS_GLOBAL')} See also

To change the position of panels on the Dashboard
1. Open the Customise dialog box.
2. Drag a panel up or down in the list to change its position on the Dashboard.

The higher up a panel is on the list, the farther to the left it appears on the Dashboard.
3. Click Done to close the Customise dialog box.

To change the position of a panel using the keyboard
1. Use an arrow key to select the item from the list in the Customise dialog box, or use the first letter of its name.

For example, press Q to select the Quick Launch buttons.
2. Press Ctrl+Alt and the arrow keys to reposition the item.
3. Click Done to close the Customise dialog box.



Adding panels
{button ,AL(`TASKS_GLOBAL')} See also
To show a hidden panel,

1. Open the Customise dialog box.
2. Select a panel in the left side of the Customise dialog box, then click Show Item.
3. Click Done to close the Customise dialog box.



Hiding panels
{button ,AL(`TASKS_GLOBAL')} See also
To hide a panel from view, do any of the following:

Select a panel in the left side of the Customise dialog box, then click Hide Item.
Right-click a snapped off panel or a panel on the Dashboard, and choose Hide from the shortcut menu.
Choose Close from the System menu of a snapped off panel.

Hiding a panel removes it from view, but it remains in memory. You can also remove a panel from view and 
memory. See Removing panels from memory.



Removing panels from memory
{button ,AL(`TASKS_GLOBAL')} See also
To hide a panel from view and remove it from memory,

1. Open the Customise dialog box.
2. Select Dashboard.
3. Click the Panels tab.
4. Select the panel you want to remove in the Panels in Use list.
5. Click Remove.
6. Click Done to close the Customise dialog box.

You can also hide a panel instead of removing it from memory. See Hiding panels.



Snapping off panels
{button ,AL(`TASKS_GLOBAL')} See also
To snap a panel off or on, do any of the following:

Right-click the panel and choose Snap On or Snap Off from the shortcut menu.
Click a panel button at the left of the Dashboard.
Check the panel as a Snap Off panel in the Customise dialog box.



Using Quick Launch buttons to launch programs
{button ,AL(`LAUNCHING')} See also
To launch a program with the Quick Launch buttons, do any of the following,

Click the Quick Launch button.
The program starts in your current Extended Screen.

Drag from a Quick Launch button to an Extended Screen.
The program starts in that Extended Screen, but Dashboard does not switch focus from the current screen.

Type its hotkey sequence.
For example, you can set Sidekick for Windows to launch when you type Ctrl+Alt+S.



Using Extended Screens to launch programs
{button ,AL(`LAUNCHING')} See also
To launch a program, drag a program icon or file name to an Extended Screen from:

The File Manager
A tab in the Programs panel
Any Quick Launch button
A program group window



Launching programs from the Programs panel
{button ,AL(`LAUNCHING')} See also
To launch a program from the Programs panel,

1. Find the tab that contains the program on the Programs panel.
Each tab corresponds to a program group Dashboard converted from the Windows 3.1 Program Manager.

2. Click the tab to see a list of all the programs in that group.
3. Click the program you want to run.



Using the Layout menu to launch programs
{button ,AL(`LAUNCHING')} See also
To launch a program with the Layout menu,

1. Click , or choose Layout Menu from the System menu.
The list of available layouts appears.

2. Choose a layout from the list.
You automatically launch all the programs saved as part of that layout. They are placed in the same positions on 
the Extended Screens that they occupied when the layout was saved. If a program was minimised when it was 
saved as part of a layout, it will be minimised when that layout is opened.



Launching programs with Dashboard Run
{button ,AL(`LAUNCHING')} See also
To launch a program with the Dashboard Run dialog box,

1. Click the Run button, or choose Dashboard Run from the Task menu.
The Dashboard Run window appears.

2. Enter the name of the program you want to run.
See Entering DOS commands in Dashboard Run.

3. Check Run Minimised if you want to run the program minimised.
4. Click Run.
5. After the program launches, select Dashboard Run again.

Hold down the Alt key and press Tab until Dashboard Run appears.
6. Click the Done button to close Dashboard Run.



Launching a program with an alarm
{button ,AL(`LAUNCHING')} See also
To set an alarm to launch a program,

1. Do one of the following:
Open the Clock Alarms dialog box by clicking a date in the calendar or double-clicking the clock.
In the Customise dialog box, click the tab for the Alarms page.

2. Click Add to add a new alarm or Edit to change an existing alarm.
The Alarm Settings dialog box appears.

3. Enter the time, date, and message text for the alarm.
4. Enter the program's path and working directory in the Application section of the Alarm Settings dialog box.
5. Check Run Minimised to have the program opened minimised.

When the alarm goes off, Dashboard launches that program and displays the alarm message you entered.
For details on setting an alarm, see Setting an alarm.



Managing open programs
{button ,AL(`LAUNCHING')} See also
In addition to the Extended Screens, Dashboard gives you three ways to keep track of your currently running 
programs, or tasks, and to switch between them.

The Taskbar
The Taskbar contains a button for each task. Clicking the button instantly activates that task. You can use the 
Taskbar as a part of the Dashboard or as a snapped-off panel.

The Task Manager
The Dashboard Task Manager takes the place of the Windows Task Manager. You can use the Task Manager to:

Switch to open programs
Close selected programs
Tile or cascade your program windows
Display information about a program.

The Task menu
The Task menu lists each task and contains other task management commands.



Saving the current configuration
{button ,AL(`CONFIGURATIONS')} See also
To save the configuration under the current name (the name that appears in the title bar of the Customise dialog 
box),

1. Display the Customise dialog box.
2. Choose Save from the File menu.
3. Click Done to close the Customise dialog box.



Creating a configuration
{button ,AL(`CONFIGURATIONS')} See also
To create a new configuration,

1. Display the Customise dialog box.
2. Choose Save As from the File menu.

The Save Configuration File dialog box appears.
3. Enter a name for the new configuration, then click OK.
4. Click Done to close the Customise dialog box.



Loading a configuration
{button ,AL(`CONFIGURATIONS')} See also
To use a Dashboard configuration that you've previously created and saved,

1. Display the Customise dialog box.
2. Choose Load from the File menu.

The Load Configuration File dialog box appears.
3. Choose the path and name of the file to load, then click OK.
4. Click Done to close the Customise dialog box.



Using drag and drop
{button ,AL(`TIPS')} See also
Dashboard makes extensive use of drag and drop, where you can perform many tasks just by dragging with the 
mouse. Here are some of the ways you can use drag and drop:

To launch a program, drag its icon from the Quick Launch panel or Programs panel, or drag the .EXE file 
name from the File Manager, to any of the Dashboard Extended Screens.

To create a new Quick Launch button, drag the program icon from a tab on the Programs panel to the Quick
Launch panel, or drag the .EXE file name from the File Manager.

To rearrange the Quick Launch buttons, drag the icons into their new positions.
To print a file, drag it from the File Manager to the current printer on the Printers panel.



Using keyboard shortcuts
{button ,AL(`TIPS')} See also
You can operate Dashboard with the keyboard as well as the mouse.
The following hotkeys are available when you install Dashboard; you can also configure hotkeys to perform other 
tasks.

F12
Bring the Dashboard to the front of other windows or, if the Dashboard is already in front, send it to the back of all 
other windows. (F12 is the default key for this function. You can use Dashboard Hotkey preferences in the 
Customise dialog box to set another hotkey for this function.)

Shift
When you hold the Shift key and click the Dashboard icon, Dashboard opens without launching the startup layout 
specified in the Save Layout dialog box.

Alt+(character)
Choose a button or menu command that has its selection character underlined. For example, if a button is labelled 
Add, the letter A is the letter for selecting the Add key, and pressing Alt+A is equivalent to clicking the button.

Alt+Spacebar
Show the System Menu.

Shift+F8
In the DOS Command box when the DOS Command Window is active, press Shift+F8 to use the up and down 
cursor keys to move through the command window. Press Shift+F8 again, and the up and down cursor keys cycle 
through a history of recent commands.

Ctrl+Alt+Cursor Keys
Move (reorder) items on a list in the Customise dialog box.

Ctrl+F6
Cycle through Dashboard and any open dialog boxes and snapped-off panels.

Arrow Keys (up/down/left/right)
Select items from menus and from groups within a dialog box. If you use Tab to select an item on the Dashboard, 
using the cursor keys will cycle through individual components of the items.

End
Move to last item on a list.

Enter
Equivalent to double-clicking the mouse on the selected item. In a dialog box, equivalent to clicking on the OK 
button.

Esc
Exit a menu. Cancel out of a dialog box.

Home
Move to first item in a list.

Spacebar
When you press Tab or Shift+Tab to select a Dashboard item, the keyboard focus is then on that item. Pressing the 
spacebar then selects that item. Using the spacebar is equivalent to clicking the mouse.

Tab
When the Dashboard has focus, use the Tab key to cycle through the Dashboard panels. When a dialog box is active,
the Tab key cycles through groups in it. 

Shift+Tab
Cycles through the reverse direction of the Tab key.



Using Dashboard's Readme file
{button ,AL(`TIPS')} See also
Dashboard installs a Readme file, README.WRI.
This Readme file contains supplemental information such as the following:

Installing Dashboard over previous versions
Removing Dashboard from your computer



Removing Dashboard
{button ,AL(`TIPS')} See also
To remove Dashboard from your system,

1. Choose the Uninstall icon from the Dashboard 95 section of the Programs menu on your Windows 95 Start 
menu.
Dashboard displays a message asking if you want to remove Dashboard from your system.

2. The Uninstall program asks if you want to remove Dashboard.
To remove Dashboard, click Remove.
To exit the program without removing Dashboard, click Cancel.

3. If you click Remove, the Uninstaller requests the path for the Dashboard program.
4. Enter the path where the Dashboard files reside, and click Delete.

Dashboard is removed from your system. One Dashboard-related file remains: DBUNINST.EXE. It is in your 
WINDOWS directory, and you must delete this file manually.



Setting up a panel
{button ,AL(`DASH_PREFS')} See also
You can set up a panel using the panel's shortcut menu or the Customise dialog box.

To set up a panel using the shortcut menu
1. Right-click a panel to display its shortcut menu.
2. From the shortcut menu, choose a menu item or choose Customise.

To set up a panel using the Customise dialog box
1. Click  to open the Customise dialog box.

2. In the list of panels on the left, select a panel.
3. Specify preferences for the panel.



Opening the Customise dialog box
{button ,AL(`DASH_PREFS')} See also
You specify preferences for all Dashboard panels in the Customise dialog box.

To open the Customise dialog box
Do one of the following:

Right-click the Dashboard title bar and choose Customise.

Click 

In the list on the left, select the panel you want to customise.



Undoing changes to the Customise dialog box
{button ,AL(`DASH_PREFS')} See also
When you click Undo in the Customise dialog box, Dashboard discards all changes made since the last time you 
saved the configuration file.



Specifying hotkeys to activate Dashboard, the Explorer, and Dashboard Run
{button ,AL(`DASH_PREFS')} See also

Keyboard shortcut
You can specify a hotkey to activate Dashboard, the Explorer, or Dashboard Run. If these programs are minimised, 
behind other windows, or in another Extended Screen, the hotkey brings it to the front and switches to the proper 
Extended Screen.

1. Click  to open the Customise dialog box.
2. Click Dashboard to display preferences for the Dashboard.
3. Click the tab for the Hotkeys page.
4. In the Dashboard, Windows Explorer, or Dashboard Run box, press the key combination on the keyboard.

Mouse shortcut
You can specify a mouse shortcut to bring Dashboard to the front.

1. Click  to open the Customise dialog box.
2. Click Dashboard to display preferences for the Dashboard.
3. Click the tab for the Hotkeys page.
4. In the Mouse Hotkey box, click the combination you want.

A mouse shortcut can be a combination of any modifying key (Alt, Shift, or Ctrl) and the mouse buttons.



Keeping Dashboard in the foreground
{button ,AL(`DASH_PREFS')} See also
You can specify that the Dashboard always appears in front of other windows, even if another window is active.

1. Right-click the title bar.
2. Choose Always In Front from the shortcut menu.

You can also specify Always In Front from the Customise dialog box.
When this option is not checked, you must activate Dashboard to bring it to the front.



Displaying the resources, date, or time in Dashboard's title bar
{button ,AL(`DASH_PREFS_APPEARANCE')} See also
To specify what to display the title bar,

1. Click  to open the Customise dialog box.
2. Click Dashboard to display preferences for Dashboard.
3. Click the tab for the Dashboard page.
4. In the Title Bar Display drop-down list, choose one of the following to specify the appearance of the title 
bar:

Standard displays the title only.

Clock/Calendar displays the date, time, and title.

Resources displays system resource information and the title.



Changing the font
{button ,AL(`DASH_PREFS_APPEARANCE')} See also
You can specify the font Dashboard uses in the Programs panel, title bar, and Extended Screens.

1. Click  to open the Customise dialog box.
2. Click Dashboard to display preferences for Dashboard.
3. Click the tab for the Appearance page.
4. In the Face Name list, select a font. This list shows the fonts currently installed on your system.
5. In the Size list, select the point size.

Depending on the font, the smallest point size available is 6 points; the largest is 12 points. The Dashboard 
resizes according to the font.

6. In the Style list, choose a style, such as Bold or Italic (when available for the selected font).
To reset default font, click Reset Defaults.



Displaying Dashboard vertically
{button ,AL(`DASH_PREFS_APPEARANCE')} See also
You can flip Dashboard into a vertical position.

1. Right-click the title bar.
2. Choose Vertical from the shortcut menu.

You can also specify Vertical from the Customise dialog box.
You move and size Dashboard the same way whether it is displayed vertically or horizontally.
If you resize the vertical Dashboard, some panels adjust to fit in the space you've defined. For example, the 
Extended Screens panel might not display the screen selectors if there is not enough room. In this case, double-click 
the screens themselves to switch back and forth, or adjust the size of Dashboard by dragging its edges.



The Quick Launch panel
{button ,AL(`QUICK_LAUNCH')} See also
Use the Quick Launch panel to launch programs with a single click, and to group the programs you use most 
frequently.
You can:

Click a Quick Launch button to run a program.

Launch a program by dragging its Quick Launch button to one of the Extended Screens.

Add programs to the panel and rearrange programs within the panel.

Snap off the Quick Launch panel and display it as a floating palette.

Quick Launch groups
The Quick Launch panel can have several groups of buttons. For example, you might have a group for icons on your
Desktop and a group for documents you use frequently. Each group has a tab on the Dashboard. When Dashboard is 
displayed horizontally, the tabs are displayed across the bottom of the Dashboard.
Dashboard creates several groups for you, and you can add groups, rename groups, and delete groups.

The App Organizer
The App Organizer searches for programs on your hard disk and puts them into Quick Launch groups. The App 
Organizer runs when you launch Dashboard for the first time and when you choose Re-Synchronise in the 
Customise dialog box.
For information on using the Quick Launch panel, click See also or click >> to browse through the topics.



Opening, closing, and hiding the Quick Launch panel
{button ,AL(`QUICK_LAUNCH')} See also

To open the Quick Launch panel

Click 

To close the Quick Launch panel

Click the Close box on the upper left corner of the snapped-off Quick Launch panel.

To hide the Quick Launch panel
1. Click  to open the Customise dialog box.

2. Click Quick Launch to display preferences for the Programs panel.
3. Click Hide Item.
When the Quick Launch panel is hidden, the list on the left indicates that the panel is "not shown." To restore the 
Quick Launch panel, click Show Item.



Snapping the Quick Launch panel on and off
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also
You can snap off the Quick Launch panel and display it as a floating palette.
You use the Quick Launch panel in the same way whether it is on Dashboard or snapped-off. Any changes you make
to the snapped-off Quick Launch panel will appear on the Dashboard when you snap the panel back on.

To snap off the Quick Launch panel
Do any of the following:

Click 

Right-click the Quick Launch panel and choose Snap Off from the shortcut menu.

To snap on the Quick Launch panel
Do any of the following:

Click 

Right-click the snapped-off Quick Launch panel and choose Snap On from the shortcut menu.



Docking the Quick Launch panel to the edge of your screen
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also
You can dock the Quick Launch panel to any edge of your screen.

To dock the Quick Launch panel
Do any of the following:

Right-click the snapped-off Quick Launch panel and choose Left, Right, Top, or Bottom from the shortcut 
menu.

In the Customise dialog box, click one of the following:

Snap to Top Edge

Snap to Left Edge

Snap to Bottom Edge

Snap to Right Edge



Auto-hiding the Quick Launch panel
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also
You can auto-hide the Quick Launch panel, which means it is hidden until you move the mouse over it.
For example, if the Quick Launch panel is docked at the top of the screen, it is hidden until you move the mouse 
pointer to the top of the screen. The Quick Launch panel then appears and remains visible until you move the mouse
away from it.

To auto-hide the Quick Launch panel
Do any of the following:

Right-click the snapped-off Quick Launch panel and choose Auto Hide.

In the Customise dialog box, choose Auto Hide.



Rearranging programs on the Quick Launch panel
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also
To move a Quick Launch button to a new location on the panel,

Drag the Quick Launch button to a new position on the panel.



Specifying the button style
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also
To specify a style for Quick Launch buttons,

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Options page.
4. Choose a button style:

Unlabeled displays only icons on the buttons.

Labelled displays icons and application names on the buttons.

Mini displays miniature buttons with icons.



Resizing the Quick Launch panel
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also
To resize the Quick Launch panel, hold down the Shift key and move the cursor to either edge of the panel. When 
the cursor changes to a sizing arrow, resize the panel. The panel displays as many buttons as possible in the space 
you've defined.



Adding a program to the Quick Launch panel
{button ,AL(`QUICK_LAUNCH_BUTTONS')} See also

To add a program by dragging,
1. Select the file in any of the following ways:

The Explorer

Programs panel

Dashboard Run's command prompt

A program window
2. Drag the program to the Quick Launch panel.

To add a program with the Customise dialog box,
1. Click  to open the Customise dialog box.

2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Applications page.
4. In the Groups list, click the group to contain the program.
5. Click New.

Dashboard creates a new entry called Untitled.
6. Enter the application's information as described in Applications page.



Changing the attributes of a Quick Launch button
{button ,AL(`QUICK_LAUNCH_BUTTONS')} See also
You can change a program's title, command line, working directory, icon, and hotkey. You can also specify whether 
it should run minimised.
To change a Quick Launch program,

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Applications page.
4. In the Groups list, click the group that contains the program.
5. In the Applications list, click the program you want to change.
6. In the Applications Settings area, change any of the program's attributes.



Specifying a hotkey for a Quick Launch button
{button ,AL(`QUICK_LAUNCH_BUTTONS')} See also
A hotkey for a Quick Launch program launches the program. If an open program is minimised, behind other 
windows, or in another Extended Screen, the hotkey brings it to the front and switches to the proper Extended 
Screen. If the program lets you launch multiple copies at the same time, the hotkey will launch a copy.
To specify a hotkey,

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Applications page.
4. In the Applications list, click the program that you want to create a hotkey for.
5. In the Shortcut Key box, press the key combination on the keyboard.
When working in DOS (either full-screen or in a window), you cannot use a hotkey to launch a program.



Launching a program and loading a file
{button ,AL(`QUICK_LAUNCH_BUTTONS')} See also
You can set up a Quick Launch button to load a data file at the same time it launches the program.

To set up a Quick Launch button to load a data file
1. Click  to open the Customise dialog box.

2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Applications page.
4. In the Applications list, select the program you want to load a data file with.
5. In the Command text box, enter the full paths to the program and the data file, in this format:

C:\WINDOWS\PBRUSH.EXE    D:\ARTWORK\PICASSO.PCX
If an association for the data file extension exists, you need to enter only the path to the data file. (To create an 
association, double-click My Computer and choose Options from the View menu. Then, click the tab for the 
File Types page. If you're not familiar with associations, see your Windows documentation.) For example, to 
launch Microsoft Word for Windows and load a data file named MEMOS.DOC, enter this into the Command 
Line text box:
C:\WINWORD\DOC\MEMOS.DOC
The file names must include extensions.

If a file name association exists, you can instantly create a Quick Launch button that loads a data file by dragging 
the data file name (for example, MEMOS.DOC) from the Windows Explorer to the Quick Launch panel.



Removing a program from the Quick Launch panel
{button ,AL(`QUICK_LAUNCH_BUTTONS')} See also

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Applications page.
4. In the Applications list, select the program you want to delete.
5. Choose Delete.

Dashboard removes the program from the Applications list and from the Quick Launch panel.



Adding a Quick Launch group
{button ,AL(`QUICK_LAUNCH_GROUPS')} See also

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Groups page.
4. Click New.

Dashboard creates a new entry called "New group".
5. In the Name text box, enter the name for the new group.

Dashboard adds the group to the Groups list and the Dashboard.



Renaming a Quick Launch group
{button ,AL(`QUICK_LAUNCH_GROUPS')} See also

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Groups page.
4. Click the group to rename.
5. In the Name text box, enter the new name for the group.



Deleting a Quick Launch group
{button ,AL(`QUICK_LAUNCH_GROUPS')} See also

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Groups page.
4. Click the group to delete.
5. Click Delete.

Dashboard removes the group from the Groups list and the Dashboard.



The Win Tools panel
{button ,AL(`WIN_TOOLS')} See also

The Win Tools panel offers single click access to frequently used Windows 95 features such as 
Find and the Explorer.
Choose the features that you work with all the time and display them on this panel.



Showing and hiding the Win Tools panel
{button ,AL(`WIN_TOOLS')} See also

To show the Win Tools panel
1. Click  to open the Customise dialog box.

2. Click Win Tools to display preferences for the Win Tools panel.
3. Click Show Item.
To hide the Win Tools panel

1. Click  to open the Customise dialog box.
2. Click Win Tools to display preferences for the Win Tools panel.
3. Click Hide Item.



Placing tools on the Win Tools panel
{button ,AL(`WIN_TOOLS')} See also

The Win Tools panel displays four Windows 95 tools that you select.
To place tools on the Win Tools panel

1. Click  to open the Customise dialog box.
2. Click Win Tools to display preferences for the Win Tools panel.
3. Select a tool from each drop-down list.

The four tools you select appear on the Win Tools panel.



The Resources panel
{button ,AL(`RESOURCES')} See also
The Resources panel contains information about your memory, disk drive space, Windows system resources, and 
your system environment. Use the Resources panel to examine resource usage and to set alarm levels for low 
resources.
The Resources panel can contain up to three sections:

Resource Gauge

CPU Meter

Drive Watch
In addition, Dashboard monitors other system resources that are only displayed in the Resources dialog box:

System Environment

Applications Running

Environment Variables
For information on using the Resources panel, click See also or click >> to browse through the topics.



Showing and hiding the Resources panel
{button ,AL(`RESOURCES')} See also

To show the Resources panel
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click Show Item.

To hide the Resources panel
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click Hide Item.



Displaying the Resources dialog box
{button ,AL(`RESOURCES')} See also

To display the Resources dialog box
Do any of the following:

Double-click the Resource Gauge section of the Resources panel.

Double-click the Drive Watch section of the Resources panel.



Resource Gauge
{button ,AL(`RESOURCES_GAUGE')} See also
Displays the amount of available memory you have.
Each running program uses up a portion of system memory. The Resource Gauge displays the percentage of 
swappable system memory. The meter drops toward empty as the percentage of available memory decreases.
For information on using the Resource Gauge, click See also or click >> to browse through the topics.



Viewing memory and resource information
{button ,AL(`RESOURCES_GAUGE')} See also

To view memory and resource information
Do any of the following:

Display the Resource Gauge on the Resources panel.
See Showing and hiding the Resource Gauge.

Display the Resources dialog box.
See Displaying the Resources dialog box.



Showing and hiding the Resource Gauge
{button ,AL(`RESOURCES_GAUGE')} See also

To show the Resource Gauge when the Resources panel is open

Right-click the Resources panel and choose Show Gauge.

To show the Resource Gauge when the Resources panel is closed
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click Show Item.
4. Click the Memory page.
5. Check Display System Resource Gauge.

To hide the Resource Gauge

Right-click the Resources panel and choose Hide Gauge.



Changing the appearance of the Resource Gauge
{button ,AL(`RESOURCES_GAUGE')} See also
You can display the Resource Gauge as different gauge types.

To change the appearance of the Resource Gauge
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Memory page.
4. Click the desired gauge in the Gauge Type list.



Showing and hiding the memory odometer
{button ,AL(`RESOURCES_GAUGE')} See also

To show the memory odometer
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Memory page.
4. Check Display System memory odometer.

To hide the memory odometer
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Memory page.
4. Uncheck Display System memory odometer.



Viewing system resources
{button ,AL(`RESOURCES_GAUGE')} See also

To view system resources
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Memory page.



Sounding an alarm for low memory
{button ,AL(`RESOURCES_GAUGE')} See also
You can sound an alarm when the available memory reaches the warning value you set. For example, if you enter 
100 for the alarm level, an alarm sounds when 100Kb or less of memory is free.

To set up a memory alarm
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Memory page.
4. Enter a warning value in the K Free box.
5. Choose the type of sound to use as the alarm. Click Play Sound if you want to try out the alarm sound.



Printing memory and resources statistics
{button ,AL(`RESOURCES_GAUGE')} See also

To print memory and resources statistics
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Memory and Resources.
3. Click Print.



Viewing system environment information
{button ,AL(`RESOURCES_SYSTEM_ENVIRONMENT')} See also
You can view information about your computer, such as the processor type, display type, and output devices.

To view system environment information
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click System Environment.



Printing system environment statistics
{button ,AL(`RESOURCES_SYSTEM_ENVIRONMENT')} See also

To print system environment information
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click System Environment.
3. Click Print.



Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also
Displays the available disk space for drives that you specify on the Drives page of the Customise dialog box.
You can monitor floppy drives, hard disk drives, and network drives.
For information on using the Drive Watch, click See also or click >> to browse through the topics.



Viewing drive usage information
{button ,AL(`RESOURCES_DRIVES')} See also

To view drive usage information
Do any of the following:

Display the Drive Watch on the Resources panel.
See Showing and hiding the Drive Watch.
Display the Resources dialog box.
See Displaying the Resources dialog box.



Showing and hiding the Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also

To show the Drive Watch when the Resources panel is open
Right-click the Resources panel and choose Show Drives.

To show the Drive Watch when the Resources panel is closed
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click Show Item.
4. Click the Drives page.
5. Check Display Drive Watch Window.

To hide the Drive Watch
Right-click the Resources panel and choose Hide Drives.



Adding drives to the Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also

To add drives to the Drive Watch
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Drives page.
4. Select the drive you want to add in the scrolling list of available drives.
5. Click Add.



Removing drives from the Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also

To remove drives from the Drive Watch
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Drives page.
4. Select the drive you want to remove in the scrolling list of available drives.
5. Click Remove.



Updating the list of available drives
{button ,AL(`RESOURCES_DRIVES')} See also
You can update the list of available drives manually. For example, if you attach to another network drive, you might 
want to update the list of available drives.

To update the list of available drives
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Drives page.
4. Click Refresh.



Setting an update interval for the Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also
Dashboard updates the information in the Drive Watch at an interval that you specify.
The update interval might affect performance, especially with large network drives. Experiment with various 
settings to determine the optimum interval for your system.

To set the update interval
1. Click  to open the Customise dialog box.

2. Click Resources to display preferences for the Resources panel.
3. Click the Drives page.
4. Enter a value in seconds in the Update Interval box.



Printing drive usage statistics
{button ,AL(`RESOURCES_DRIVES')} See also

To print memory and resources statistics
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Drive Usage.
3. Click Print.



Viewing applications running information
{button ,AL(`RESOURCES_APPLICATIONS')} See also
You can view currently open programs and their memory size.

To view information about running applications
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Applications Running.



Closing running applications
{button ,AL(`RESOURCES_APPLICATIONS')} See also

To close a running application
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Applications Running.
3. Select the application that you want to close.
4. Click Close Application.



Updating the application list
{button ,AL(`RESOURCES_APPLICATIONS')} See also

To update the list of running applications
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Applications Running.
3. Click Refresh.



Printing running application statistics
{button ,AL(`RESOURCES_APPLICATIONS')} See also

To print running application statistics
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Applications Running.
3. Click Print.



Viewing environment variables information
{button ,AL(`RESOURCES_ENVIRONMENT_VARS')} See also
You can view the environment variables your system is currently using.

To view environment variables
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Environment Variables.



Printing environment variables statistics
{button ,AL(`RESOURCES_ENVIRONMENT_VARS')} See also

To print environment variables statistics
1. Double-click the Resource Gauge or Drive Watch sections of the Resources panel.

The Resources dialog box appears.
2. Click Environment Variables.
3. Click Print.



CPU Meter
{button ,AL(`RESOURCES')} See also
Displays the following information about your system:

CPU activity.
CPU activity tells you how busy your central processing unit is.
Threads.
Threads are simultaneous activities.
Virtual machines.
Windows 95 is one virtual machine, and each DOS window is another virtual machine.



The Clock/Calendar panel
{button ,AL(`CLOCK_CALENDAR')} See also
The clock and calendar display your system date and time.
You can:

Set your system date and time.
Scroll through the display of months.
Set alarms, and set the snooze interval for alarms. You can set an alarm to go off on a recurring basis or for 

one time only.
Change the appearance of the clock; it can be digital or analogue and it can display a second hand.
Change the colours the calendar displays for the current date and for days containing alarms.
Display the current date and time on the Dashboard title bar.

About alarms
The Dashboard alarms can help you keep track of your busy schedule. You can set an alarm to remind you of an 
appointment or to launch a program. You can repeat the same alarm every day or on a specific day of the week. And 
you can set an alarm weeks, or even months, in advance.

How alarms are displayed
When an alarm goes off, a message box appears. You can either click OK to close the alarm message box or click 
Snooze to close the alarm message for a specified snooze interval.
If you don't close the alarm message within an hour, Dashboard closes it.
To adjust the volume and duration of the alarm sound, use the Windows Control Panel.

Note: Alarms appear only when Dashboard is running.



Showing and hiding the clock and calendar
{button ,AL(`CLOCK_CALENDAR')} See also

To display the clock or calendar
Do one of the following:

Right-click the Clock/Calendar panel and choose Show Clock or Show Calendar.
In the Customise dialog box, check Show Clock or Show Calendar.

To hide the clock or calendar
Do one of the following:

Right-click the Clock/Calendar panel and choose Hide Clock or Hide Calendar.
In the Customise dialog box, uncheck Show Clock or Show Calendar.

To hide the Clock/Calendar panel
1. Click  to open the Customise dialog box.

2. Click Clock/Calendar to display preferences for the Clock/Calendar panel.
3. Click Hide Item.
When the Clock/Calendar panel is hidden, the list on the left indicates that the panel is "not shown." To restore the 
Clock/Calendar panel, click Show Item.



Scrolling through the calendar
{button ,AL(`CLOCK_CALENDAR')} See also
When you start Dashboard, the calendar shows the current month, with the current date highlighted.
Click the scroll buttons in the top corners to view past and future months.
Hold down the Shift key and click the scroll buttons to scroll forward or back a year at a time.



Setting your computer's date and time
{button ,AL(`CLOCK_CALENDAR')} See also
To set your system date or time, do one of the following:

Right-click the Clock/Calendar panel and choose Change Date/Time.
In the Customise dialog box, choose Change Date/Time.



Specifying an analogue or digital clock
{button ,AL(`CLOCK_CALENDAR_APPEARANCE')} See also
To change the clock style to analogue or digital, do one of the following:

Right-click the Clock/Calendar panel and choose Analogue or Digital.
In the Customise dialog box, choose Analogue or Digital.

The analogue clock shows time with minute and second hands pointing to numbers, and the digital clock represents 
time as a number.



Choosing a clock face
{button ,AL(`CLOCK_CALENDAR_APPEARANCE')} See also
To choose a clock face,

1. Click  to open the Customise dialog box.
2. Click Clock/Calendar to display preferences for the Clock/Calendar panel.
3. Click the tab for the Clock page.
4. In the Clock Face list, choose one of the predefined clock faces.

As you click the names of the clock faces, Dashboard displays the clock face in the panel on the right.



Displaying the clock's second hand
{button ,AL(`CLOCK_CALENDAR_APPEARANCE')} See also
When an analogue clock is displayed, you can show or hide the second hand.

To display or hide the clock's second hand
Do one of the following:

Right-click the Clock/Calendar panel and choose Show Second Hand or Hide Second Hand.
In the Customise dialog box, check Show Second Hand.

Note: The second hand may interfere with some communication programs. If your communication program is 
experiencing unnecessary time-outs, try hiding the second hand.



Specifying colours for the calendar
{button ,AL(`CLOCK_CALENDAR_APPEARANCE')} See also
You can specify the colour Dashboard uses to highlight today's date and days for which alarms are set.

To specify colours for the calendar
1. Click  to open the Customise dialog box.

2. Click Clock/Calendar to display preferences for the Clock/Calendar panel.
3. Click the tab for the Calendar page.
4. Click a colour for the Current Day and for Days with Alarms.

To turn off colours for the calendar
1. Click  to open the Customise dialog box.

2. Click Clock/Calendar to display preferences for the Clock/Calendar panel.
3. Click the tab for the Calendar page.
4. Check No Highlights.



Setting an alarm
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also
Dates with alarms are highlighted in the calendar.

To set an alarm
1. Display the Clock Alarms dialog box by doing one of the following:

Click a date on the calendar.
Right-click the Clock/Calendar panel and choose Alarms.
Double-click the clock.

Dashboard lists any alarms currently set.
2. Click Add.

The Alarm Settings dialog box appears. Dashboard sets the date for the alarm depending on how you opened the
Clock Alarms dialog box.

3. In the Alarm Text box, type the text you want displayed in the alarm message.
4. Specify a time for the alarm. Enter the hour and minutes or click the arrows. Select AM or PM from the drop-

down list.
5. Specify whether you want the alarm to go off on a regular basis or once only.

Choose Recurring and select a day if you want the alarm to go off on the same day of every week.
Choose Date and enter the day, month, and year if you want the alarm to go off only once. To change the 

date, select a portion of the date and click arrows.
6. To launch a program with the alarm, enter the program's path and the working directory.
7. Choose the alarm's sound from the Chime drop-down list. To hear a sound, select it and click Play Chime.
8. Click OK.

Dashboard lists the alarm in the Clock Alarms dialog box.
9. Click OK in the Clock Alarms dialog box.



Changing an alarm
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also
To change an alarm,

1. Display the Clock Alarms dialog box by doing one of the following:
Click a date on the calendar.
Right-click the Clock/Calendar panel and choose Alarms.
Double-click the clock.

Dashboard lists any alarms currently set.
2. Select the alarm to change and click Edit.

The Alarm Settings dialog box appears, with details about the selected alarm.
3. Change the alarm as desired.
4. Click OK.

Dashboard lists the modified alarm in the Clock Alarms dialog box.
5. Click OK in the Clock Alarms dialog box.



Setting the snooze interval
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also
When an alarm appears, you can click Snooze to shut if off temporarily. The alarm will sound again after a set 
number of minutes known as the snooze interval.

To set the snooze interval
1. Display the Clock Alarms dialog box by doing one of the following:

Click a date on the calendar.
Right-click the Clock/Calendar panel and choose Alarms.
Double-click the clock.

2. In the Snooze Interval box, type the number of minutes for the snooze interval, or use the arrows to raise or 
lower the current value.

You can also set the snooze interval in the Customise dialog box.



Deleting an alarm
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also
To delete an alarm,

1. Display the Clock Alarms dialog box by doing one of the following:
Click a date on the calendar.
Right-click the Clock/Calendar panel and choose Alarms.
Double-click the clock.

Dashboard lists any alarms currently set.
2. Select the alarm to delete and click Delete.

Dashboard removes the alarm from the list.
3. Click OK.



The Printers panel
{button ,AL(`PRINTER_PANEL')} See also
The Printers panel lists all the currently installed printers, fax machines, plotters, and other output devices. Below 
the printer icon, Dashboard lists the port the printer is connected to. With ToolTips enabled, rest your mouse pointer 
over a printer icon to see the full name and description.
You can:

Print or fax a file by dragging it to the desired printer icon.
You can drag a file from the File Manager, the Programs panel, a program group window, the Quick 

Launch panel, or the Command prompt in the Run dialog box.
Choose which print devices (printers, plotters, and fax machines) you want to appear in the Printers panel.
Specify the order in which print devices appear in the Printers panel.
Change the default printer.
Specify the icons and descriptions for each printer.

For information on using the Printers panel, click See also or click >> to browse through the topics.



Opening, closing, and hiding the Printers panel
{button ,AL(`PRINTER_PANEL')} See also

To open the Printers panel
Click 

To close the Printers panel
Click the Close box on the upper left corner of the snapped-off Printers panel.

To hide the Printers panel
1. Click  to open the Customise dialog box.

2. Click Printers to display preferences for the Printers panel.
3. Click Hide Item.
When the Printers panel is hidden, the list on the left indicates that the panel is "not shown." To restore the Printers 
panel, click Show Item.



Printing or faxing a file
{button ,AL(`PRINTER_PANEL')} See also
To print or fax a file,

1. Select a file to print. You can select a file from any of the following:
The Explorer, My Computer, and Network Neighborhood
The File Manager
A menu on a Programs panel tab
A program group window
The Quick Launch panel
The command prompt in the Dashboard Run dialog box

2. Drag the file to the appropriate printer icon on Dashboard. If the printer is not currently displayed on 
Dashboard, use the scroll arrows on Dashboard to display it.

Programs that support drag-and-drop printing are listed in the Windows registration database. If a program is not 
listed in this database, drag-and-drop printing will not work. Consult your Windows documentation for information 
on how to add an unlisted program to the Windows registration database.



Specifying the default printer
{button ,AL(`PRINTER_PANEL_CONFIGURING')} See also
The green default printer light at the bottom of the printer icon indicates the default printer.

To specify the default printer
1. Scroll the Printers panel until the printer you want is visible.
2. Click the default printer light on the printer you want to use.

You can also specify the default printer in the Customise dialog box.



Installing a new printer
{button ,AL(`PRINTER_PANEL_CONFIGURING')} See also
The Printers panel displays all the printers you have installed in Windows.

To install a new printer
1. Display the Windows control panel.
2. Click the Printers icon.
3. Follow the instructions in your Windows documentation.



Setting up a printer
{button ,AL(`PRINTER_PANEL_CONFIGURING')} See also
To set up a printer, do any of the following:

Double-click the printer in the Printers panel
Right-click the printer in the Printers panel and choose Setup.

Follow the instructions in your Windows documentation to complete the setup.
You can also set up a printer in the Customise dialog box.



Snapping the Printers panel on and off
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also
You can snap off the Printers panel and display it as a floating palette.
You can use the Printers panel in the same way whether it is on Dashboard or snapped off. Any changes you make to
the snapped-off Printers panel will appear on the Dashboard when you snap the panel back on.

To snap off the Printers panel
Do any of the following:

Click 

Right-click the Printers panel and choose Snap Off from the shortcut menu.

To snap on the Printers panel
Do any of the following:

Click 

Right-click the snapped-off Printers panel and choose Snap On from the shortcut menu.



Rearranging printers on the Printers panel
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also
To rearrange the printers, do any of the following:

Click an icon on the Printers panel and drag it to a new location.
Use the Customise dialog box.



Resizing the Printers panel
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also
If the Printers panel is not wide enough to display all printers, it includes scroll arrows.

To change the size of the Printers panel
1. Hold down the Shift key and click the edge of the Printers panel.

The pointer changes to the resize cursor.
2. Drag to resize the panel.



Changing the description of the printer
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also
The description of the printer appears above the icon and in the ToolTip help.

To change the printer's description
1. Click  to open the Customise dialog box.

2. Click Printers to display preferences for the Printers panel.
3. Select the printer that you want to change.
4. In the Description box, enter a new description of the printer.



Changing the printer icon
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also
An icon identifies each printer on the Printers panel.

To change the printer icon
1. Click  to open the Customise dialog box.

2. Click Printers to display preferences for the Printers panel.
3. Select the printer that you want to change.
4. Click Change Icon.
5. Select an icon from the list and choose OK.



Displaying the paper orientation
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also
An icon optionally identifies the paper orientation of each printer on the Printers panel.

To display the paper orientation
1. Click  to open the Customise dialog box.

2. Click Printers to display preferences for the Printers panel.
3. Click the tab for the Options page.
4. Check Show Paper Orientation.

The printer icon shows the paper orientation.



The Extended Screens panel
{button ,AL(`EXT_SCREENS')} See also

Using Dashboard's Extended Screens is like connecting your computer to several side-by-side 
monitors. Each Extended Screen represents a full-screen view. You can open programs on the 
Extended Screens and then switch back and forth among them to work with the different 
programs.
For example, suppose you want to work with Sidekick, Paradox for Windows, and Quicken. 
Rather than piling these programs up on the same screen, open Sidekick on the first Extended 
Screen, Paradox on the second, and Quicken on the third.
Mini windows correspond to open programs
Dashboard's extended screens contain miniature windows corresponding to the open program 
windows, displaying the icons and titles of programs in those windows.
Icons on the Extended Screens panel let you tile and cascade the windows within the current 
extended screen:

Tiles open windows vertically
Tiles open windows horizontally
Cascades open windows

Extended screens are fully interactive
The Extended Screens are completely interactive with the full-screen views. If you move or 
resize a program window on the full screen, the miniwindow also moves and resizes. If you bring
one program on top of another, the miniwindows on the Extended Screens reflect the change.
It also works the other way. If you move miniwindows on the Extended Screens, the programs 
they represent move on the full screen.
In fact, you can move a program miniwindow from one Extended Screen to another just by 
dragging it there.

Note:If you resize the Dashboard, the screen selectors may disappear. If this happens, you can 
double-click the screens themselves to switch back and forth, or define Extended Screen 
hotkeys.



Switching between Extended Screens
{button ,AL(`EXT_SCREENS')} See also

To switch from one Extended Screen to another, you activate the screen you are switching to.
To switch to an Extended Screen
Do one of the following:

Click the screen selector, which is the box at the bottom of the Extended Screen. (If the 
Extended Screens are displayed in Compact form, click the mini icon that represents the screen 
you want to activate.) The Dashboard remains on top.

Double-click an Extended Screen. If you double-click the screen background, the 
Dashboard remains on top. If you double-click a program's miniwindow, the program comes to 
the top.

Press a hotkey. The program comes to the top, if a program is open in that screen.



Moving an open program to a different Extended Screen
{button ,AL(`EXT_SCREENS')} See also

To move open windows among the Extended Screens,
Drag the mini-windows in the Extended Screens.



Assigning hotkeys to Extended Screens
{button ,AL(`EXT_SCREENS')} See also

By assigning hotkeys to your Extended Screens, you can use the keyboard to switch between 
Extended Screens.
To assign hotkeys to Extended Screens

1. Click  to open the Customise dialog box.
2. Click Extended Screens to display preferences for the Extended Screens.
3. Click the tab for the Hotkeys page.
4. Click in the text box and press a key sequence.

To clear an existing hotkey sequence, click in the text box and press Del or Backspace.
In Dashboard's horizontal orientation, the numerical sequence of screens in the Customise dialog 
box corresponds to the left-to-right order of the screens on Dashboard. In the vertical orientation,
the numerical sequence corresponds to the top-to-bottom order on Dashboard.



Hiding the Extended Screens panel
{button ,AL(`EXT_SCREENS')} See also

To hide the Extended Screens panel so it does not appear on the Dashboard,
1. Click  to open the Customise dialog box.

2. Click Extended Screens to display preferences for the Extended Screens.
3. Click Hide Item.
When the Extended Screens panel is hidden, the list on the left indicates that the panel is "not 
shown." To restore the Extended Screens panel, click Show Item.



Specifying the display size for Extended Screens
{button ,AL(`EXT_SCREENS_APPEARANCE')} See also

You can display the Extended Screens in their default size, or in a compact form that shows small
boxes without icons for open programs.
To specify the display size for Extended Screens

1. Click  to open the Customise dialog box.
2. Click Extended Screens to display preferences for the Extended Screens.
3. Click the tab for the Screens page.
4. Choose one of the following:

Full Size displays the screens at their largest possible size.
Compact displays the screens as mini icons.



Specifying the number of Extended Screens
{button ,AL(`EXT_SCREENS_APPEARANCE')} See also

To specify the number of screens for the Extended Screens panel,
1. Click  to open the Customise dialog box.

2. Click Extended Screens to display preferences for the Extended Screens.
3. Click the tab for the Screens page.
4. Click a number in Number of Screens.
The numbers are dimmed when Dashboard does not have enough space for that many Extended 
Screens.
If you decrease the number of Extended Screens, any applications in the removed screens are 
moved into the remaining screens.



Specifying the background colour for Extended Screens
{button ,AL(`EXT_SCREENS_APPEARANCE')} See also

You can choose a predefined background for the Extended Screens, or you can specify your own 
bitmap.
To choose the background colour

1. Click  to open the Customise dialog box.
2. Click Extended Screens to display preferences for the Extended Screens.
3. Click the tab for the Screens page.
4. In the Background section, specify one of the following:

Predefined displays a list of backgrounds provided with Dashboard.
Use Windows Background uses the wallpaper currently specified in your Windows 

Control Panel.
Bitmap lets you specify any .BMP file. Type the path into the text box, or click Browse to

locate the file.



About sticky apps
{button ,AL(`EXT_SCREENS_STICKY')} See also

When you're working with Extended Screens, you'll want some programs to be assigned to a 
single screen. But you might want others such as Sidekick or your email program
accessible from every Extended Screen. You do this by designating these applications as sticky 
apps.
If you minimise a sticky app, its icon is visible in each Extended Screen.



Creating a sticky app
{button ,AL(`EXT_SCREENS_STICKY')} See also

You can designate any running program as a sticky app.
To create a sticky app

1. Launch the program you want to designate as a sticky app.
2. Click  to open the Customise dialog box.

3. Click Extended Screens to display preferences for the Extended Screens.
4. Click the tab for the Sticky Apps page.
5. Click Add.

The Add Sticky App dialog box appears.
6. Select a program from the list and choose OK.

Dashboard displays the Customise dialog box and lists the selected program.



Removing a sticky app
{button ,AL(`EXT_SCREENS_STICKY')} See also

Once you designate a program as a sticky app, you can remove it at any time.
To remove a sticky app

1. Click  to open the Customise dialog box.
2. Click Extended Screens to display preferences for the Extended Screens.
3. Click the tab for the Sticky Apps page.
4. Select the sticky app you want to delete.
5. Click Delete.

Dashboard deletes the program from the list of sticky apps.



About layouts
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

A layout is an arrangement of open programs in the Extended Screens. You might find, for 
example, that different arrangements are best suited to different tasks.
You can create and save layouts for each of your projects or tasks. When you start working on a 
project, load its layout. The programs you need automatically open into the designated Extended 
Screens.
The Layout menu contains the commands to save, load, and manage layouts.
Layouts and the Windows Startup group
Layouts are one way to load programs automatically; the Windows StartUp group is another. Be 
sure your Dashboard layouts don't load programs that are already loaded by the StartUp group. 
For maximum flexibility, put Dashboard in your Windows StartUp group, and use Dashboard's 
layouts to load other applications as needed.
Layouts and configurations
Layouts are different from configurations:

A layout is the arrangement of program windows in the Extended Screens.
A configuration is the arrangement of items (such as the Quick Launch panel, Extended 

Screens, and Printers panel) on the Dashboard.
Layouts and configurations are sometimes related. For example, a layout that uses five Extended 
Screens requires a configuration with five screens. (If the current configuration has only three 
screens, Dashboard "doubles up" the programs from the extra screens to fit into three.)
If you create a complex layout that requires a special configuration, save the configuration as a 
separate file. When you want to work with the layout, first open the configuration, and then open
the layout.



Creating a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To create a layout,
1. Arrange the programs on the Extended Screens the way you want them to appear when the 

layout appears.
2. Click  to display the Layout menu.

3. Choose Save Layout from the Layout menu
The Save Layout dialog box appears.

4. Enter a name for the layout. If you accept the default name, "Default", the layout is named 
"Default".

5. Choose OK.
Dashboard creates the layout and adds its name to the Layout menu.



Loading a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

Once you have created a layout by saving it, you can launch all its associated applications 
quickly by loading that layout.
To load a layout

1. Click  to display the Layout menu.
The Layout menu lists your saved layouts as well as a sample layout.

2. Click the layout you want to load, or click Load Sample Layout.
Dashboard launches all programs associated with the layout.

Keep the following in mind when loading layouts:
If a program is already open when you load a layout that uses the same program, but is in 

a different Extended Screen or location within the Extended Screen, the program is not 
repositioned.

Loading a layout doesn't unload or close any programs that are already open. Thus, if 
you've already opened some programs when you load a layout, you'll get the programs in the 
layout plus the open programs. For that reason, you might want to close some or all programs 
before loading a layout. You can close all programs by clicking 

 to display the Task menu and choosing Close All Programs.



Loading a layout on startup
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To create a layout that automatically loads when you start Dashboard,
1. Arrange the programs on the Extended Screens the way you want them to appear when the 

layout appears.
2. Click  to display the Layout menu.

3. Choose Save Layout from the Layout menu.
The Save Layout dialog box appears.

4. Enter a name for the layout.
5. Check Load Layout on Startup.
6. Choose OK.

Dashboard creates the layout and adds its name to the Layout menu. When you start Dashboard, 
this layout is automatically loaded.
Although you can create more than one startup layout, you'll probably find that one is enough.
To disable the automatic loading of a startup layout
To start Dashboard without loading the layout, hold down the Shift key when you double-click 
the Dashboard icon. Dashboard will not launch the startup layout.



Viewing layouts on the Quick Launch panel
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

Dashboard provides a Quick Launch group that contains a button for each layout you've defined. 
When you display this Quick Launch group, you can launch layouts with a single click.
To display the Layouts Quick Launch group

1. Click  to open the Customise dialog box.
2. Click Quick Launch to display preferences for the Quick Launch panel.
3. Click the tab for the Groups page.
4. Click Layouts Tab.



Removing a program from a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To remove a program from a layout,
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select a layout.
4. In the Applications list, select the program to delete.
5. Choose Delete.

Dashboard removes the program from the list.
6. Choose Save Changes.

You can also remove a program using the Save Layout dialog box.
Caution: The Delete Layout button deletes the entire layout. Don't confuse it with the 

Delete button, which removes a program from the layout.



Changing a program's layout information
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To change a program's information in a layout,
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select a layout.
4. In the Applications list, select the program to change.
5. Choose Edit.

The Edit Layout dialog box appears.
6. Enter changes to the program's information.
7. Choose OK.
8. In the Manage Layouts dialog box, choose Save Changes.

You can also edit a program using the Save Layout dialog box.



Renaming a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To change a layout's name,
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select a layout.
4. Choose Rename.

The Rename Layout dialog box appears.
5. Specify a new name for the layout.
6. Choose OK.
7. In the Manage Layouts dialog box, choose Save Changes.



Deleting a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To delete a layout,
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select the layout to delete.
4. Choose Delete.
5. When Dashboard asks you to confirm the deletion, choose Yes.
6. Choose OK.
7. In the Manage Layouts dialog box, choose Save Changes.



The Games panel
{button ,AL(`GAMES')} See also

After you've put Dashboard to work for you, you can use it to help you unwind. Use the Games 
panel to try your luck at poker or a slot machine. Or challenge your mind by solving the slide 
puzzle.
You can adjust your wager in poker and slots. The slide puzzle is a fixed wager depending on 
which of the three puzzles you choose to solve. To see how you've been playing, double-click the
Games panel to display a graph of your finances.



Showing and hiding the Games panel
{button ,AL(`GAMES')} See also

To show the Games panel
1. Click  to open the Customise dialog box.

2. Click Games to display preferences for the Games panel.
3. Click Show Item.
To hide the Games panel

1. Click  to open the Customise dialog box.
2. Click Games to display preferences for the Games panel.
3. Click Hide Item.



Choosing a game
{button ,AL(`GAMES')} See also

You can place any of the following games on the Games panel:
Poker
Slot machine
Slide puzzle

To choose a game
1. Click  to open the Customise dialog box.

2. Click Games to display preferences for the Games panel.
3. In Game Type, click the game that you want to play.



Adjusting your bet
{button ,AL(`GAMES')} See also

The default bet is the amount of money Dashboard automatically places for you each time you 
play poker or the slot machine. You can change the default bet manually before you play a game.
To set a default bet

1. Click  to open the Customise dialog box.
2. Click Games to display preferences for the Games panel.
3. In Game Type, click the game that you want to play.
4. In Default Bet, choose the amount of money to use as a default bet.
To change a bet when you play

Change the bet on the Games panel before you click Deal for the poker game or Spin for 
the slot machine.



Graphing your progress
{button ,AL(`GAMES')} See also

Dashboard keeps track of your winnings and losses over time. You can display a graph of your 
progress to see how well you've played.
To graph your progress
Do any of the following:

Double-click the Games panel.
Right-click the Games panel and choose Show Graph.



Resetting your stake
{button ,AL(`GAMES')} See also

Dashboard provides you with a starting stake of £200. You can reset your stake to that amount at 
any time.
To reset your stake

1. Click  to open the Customise dialog box.
2. Click Games to display preferences for the Games panel.
3. Click Reset Money.



Playing poker
{button ,AL(`GAMES')} See also

To play poker
1. Place your bet on the Games panel.
2. Click Deal.

Dashboard displays five new cards and deducts your bet from your stake.
3. Click each card that you want to keep.

Dashboard indicates the cards you are keeping with a green light.
4. Click Draw.

Dashboard replaces the cards you discarded.
When you win, Dashboard displays a message and adds the amount of your winnings to your 
stake. You need a pair of Jacks or better to win.



Playing the slot machine
{button ,AL(`GAMES')} See also

To play slots
1. Place your bet on the Games panel.
2. Click Spin.

Dashboard spins the slot machine and deducts your bet from your stake.
When you win, Dashboard displays a message and adds the amount of your winnings to your 
stake.



Playing the slide puzzle
{button ,AL(`GAMES')} See also

To set up the slide puzzle
1. Click  to open the Customise dialog box.

2. Click Games to display preferences for the Games panel.
3. Click Slide Puzzle.
4. Click the slide puzzle that you want to try.
5. Click Done.

Dashboard places the slide puzzle with one missing piece on the Games panel.
To play the slide puzzle

Click a piece that is adjacent to the missing piece.
Dashboard moves the piece into the open spot and deducts one dollar from your stake.

Each slide puzzle pays off in a fixed amount of dollars. When you win, Dashboard adds the fixed
amount for that slide puzzle to your stake.



Dashboard Run
{button ,AL(`DASH_RUN')} See also

Dashboard Run takes the place of both a DOS prompt and the Run command on the Windows 
Start menu. You can enter DOS commands copy files, view directories, and manage programs
right from Dashboard.
The results window
The results window appears in the lower part of the Dashboard Run window. The results window
displays a command prompt and the result of DOS commands that you enter. You can also run 
commands that appear in the results window.



DOS commands supported by Dashboard Run
{button ,AL(`DASH_RUN')} See also

Dashboard displays the result of supported DOS commands in the results window of Dashboard 
Run. If Dashboard does not support a DOS command, it passes the command on to DOS, where 
it is executed in a new DOS window. This DOS window remains open until you manually close 
it.
The following list shows you all the commands you can use at the Dashboard Run command 
prompt. To view an explanation of a specific command and the command syntax, click the 
command.
attrib
call
cd (chdir)
cls
copy
date
del (erase)
dir
echo
edit
exit
find
for
goto
help
if
label
md(mkdir)
path
pause
print
prompt
rd (rmdir) 
rem
ren (rename)
set
shift
sort
time
type
ver
vol
xcopy
The Dashboard Run dialog box does not support the Append, Choice, Defrag, DOSkey, 
Fastopen, Graphics, Join, Loadhigh, More, or Share commands.
Copyright© 1992-1993 Summit Software Company.
All rights reserved.





Launching Dashboard Run
{button ,AL(`DASH_RUN')} See also

To launch Dashboard Run
Do any of the following:

Click the 
 button.

Double-click the 
 button.

Choose Dashboard run from the Task menu.



Entering DOS commands in Dashboard Run
{button ,AL(`DASH_RUN')} See also

Use the Command Line box or the results window to enter DOS commands.
To enter DOS commands in the Command Line box
Do any of the following:

Type the command in the Command Line box, and then click Run.
Use the Browse button to place the command in the Command Line box, and then click 

Run.
Click the arrow in the Command Line box to display the history list. If the command is 

displayed, choose it and then click Run.
To enter DOS commands in the results window
Do any of the following:

Type the command at the DOS prompt in the results window, and then press Enter.
If the results window contains a DIR listing that displays the name of the command, 

double-click the command or drag it to an extended screen.
If the results window contains a DIR listing that displays the name of the command, press

Shift+F8 to select the bottom file name, use the arrow keys to select the desired command name, 
and then press Enter.



The Programs panel
{button ,AL(`PROGRAM_PANEL')} See also
The Programs panel displays each of your program groups as a tab. Launching a program is as simple as clicking 
once on its group, and clicking the program name.
If you have been running an earlier version of Windows, the Programs panel helps your transition to Windows 95. 
Dashboard's Programs panel provides all the functionality of the Windows 3.1 program groups, and more.
You can:

Click a program group's tab to display a menu of items in that group.
Launch a program by clicking the program item in the list or dragging it to an extended screen.
Choose the order in which groups appear on the Programs panel.
Add groups, modify and delete groups, and open a group's window.
Snap off the Programs panel to display it as a floating palette.

When you install Dashboard, the initial group of Programs tabs consists of the following:
Programs from your Windows 95 Programs menu
Folders that contain programs

For information on using the Programs panel, click See also or click >> to browse through the topics.



Opening, closing, and hiding the Programs panel
{button ,AL(`PROGRAM_PANEL')} See also

To open the Programs panel
Click 

To close the Programs panel
Click the Close box on the upper left corner of the snapped-off Programs panel.

To hide the Programs panel
1. Click  to open the Customise dialog box.

2. Click Programs to display preferences for the Programs panel.
3. Click Hide Item.
When the Programs panel is hidden, the list on the left indicates that the panel is "not shown." To restore the 
Programs panel, click Show Item.



Snapping the Programs panel on and off
{button ,AL(`PROGRAM_PANEL_APPEARANCE')} See also
You can snap off the Programs panel and display it as a floating palette.
You use the Programs panel in the same way whether it is on Dashboard or snapped off. Any changes you make to 
the snapped-off Programs panel will appear on the Dashboard when you snap the panel back on.

To snap off the Programs panel
Do any of the following:

Click 

Right-click the Programs panel and choose Snap Off from the shortcut menu.

To snap on the Programs panel
Do any of the following:

Click 

Right-click the snapped-off Programs panel and choose Snap On from the shortcut menu.



Rearranging groups on the Programs panel
{button ,AL(`PROGRAM_PANEL_APPEARANCE')} See also
You can rearrange groups in a custom order, or you can sort them alphabetically.

To move a group to a new location
Do any of the following:

Click a tab on the Programs panel and drag it to a new location.
In the Customise dialog box, click a group and drag it to a new position in the list.

To sort the groups
Do any of the following:

Right-click the Programs panel and choose Sort Groups from the shortcut menu. This sorts the groups 
alphabetically.

In the Customise dialog box, click Sort Alphabetically or Sort By Colour.
Dashboard immediately sorts the groups.

How the list of groups corresponds to the Dashboard
In Dashboard's horizontal orientation, the top-to-bottom sequence in the list corresponds to how program 

groups are arranged from left to right on Dashboard.
In Dashboard's vertical orientation, the top-to-bottom sequence in the list corresponds to how program 

groups are arranged from top to bottom on Dashboard.



Displaying colours and text for Programs panel tabs
{button ,AL(`PROGRAM_PANEL_APPEARANCE')} See also
Each program group includes one or two lines of text to identify the group, and each tab on the Programs panel can 
include a coloured corner called a colour key
to make it more identifiable.
1. Click  to open the Customise dialog box.

2. Click Programs to display preferences for the Programs panel.
3. To show colour keys and text, do any of the following:

Check Show 2nd Row of Text to display two rows of text (full size).
Check Show Colour Keys to display colours in the Programs panel.

4. In the Program Groups list, click the group you want to modify.
5. Click Modify.
6. Enter a new group description or select a new colour setting as described in Modify Program Group dialog box.

The description and colour you specify will appear on the group's tab in the Programs panel.
You can also right-click the Programs panel and choose Hide 2nd Line from the shortcut menu.



Hiding a group
{button ,AL(`PROGRAM_PANEL_APPEARANCE')} See also
To hide a program group so that it doesn't appear on the Programs panel,

1. Click  to open the Customise dialog box.
2. Click Programs to display preferences for the Programs panel.
3. In the Program Groups list, click the group you want to hide.
4. Click Hide Group.
If you want to show the group again, click the group and click Show Group.



Overview of managing program groups
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
Dashboard program groups organise your programs in tabs. Here are some of the things you can do with program 
groups:

Display Program groups as a row of tabs in the Programs panel.
Create groups within a group.
Change a group's description.
Change the order in which program groups appear in the menu by sorting them or dragging the group name

to the position you want.
Add a program to a group by dragging the program's icon from the Quick Launch panel to the group 

window. Or
in the opposite direction
instantly create a Quick Launch button by dragging a program icon from a group to the Quick Launch panel.
For information on managing program groups, click See also or click >> to browse through the topics.



Opening a group
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
You can open a program group as a window that displays program items as icons.

To open a group's window
Do any of the following:

Double-click the group's tab in the Programs panel.
Click the group's tab in the Programs panel and choose the group name from the menu that appears. (The 

program group itself is always the first item listed in its menu.)
You can also open a group's window from the Customise dialog box.



Creating a group
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
You can create a new program group right from Dashboard. The new group is automatically reflected in the 
Programs panel.

To create a program group
1. Click  to open the Customise dialog box.

2. Click Programs to display preferences for the Programs panel.
3. Click New.
4. Enter the following information for the group:

The group name that will appear on the group's tab in the Programs panel
The colour that will appear on the group's tab in the Programs panel.



Deleting a group or an item in a group
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
When you delete a program group or an item in a group, the deletion is automatically reflected in the Windows 95 
Programs menu.

To delete a program group
1. Click  to open the Customise dialog box.

2. Click Programs to display preferences for the Programs panel.
3. Select the group you want to delete.
4. Click Delete.

Dashboard asks you for confirmation, then deletes the group.
Deleting a program group deletes all of the items and groups contained within it.

To delete an item in a group
1. Open a group by double-clicking its tab in the Programs panel.
2. Click the program item or program group you want to delete.
3. Press the Del key or choose Delete from the File menu.

Dashboard asks you for confirmation, then deletes the item.



Adding an item to a group
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
You can add a program to a group if the group is open. The new program item is automatically reflected in the 
Windows 95 Programs menu.

To add a program to a program group
1. Open a group by double-clicking its tab in the Programs panel. Or click the group tab, and then click the group 

name at the top of the list.
2. Choose New from the File menu.
3. Choose Shortcut.
4. Enter the program's command line, or click Browse and find the program you want. Complete the steps for 

creating a Windows 95 shortcut.
The new program item's icon appears in the group window.

To add a program by dragging
You can also add a new item by dragging it from the Explorer, another program window, or the Quick Launch panel 
to the group.



Creating a group within a group
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
You can reduce the number of items on the Programs panel or consolidate your program groups by creating groups 
within groups. A group within another group is called a nested group.
You can add programs or even other groups
to a nested group.

To create a nested group
1. Open a group by double-clicking its tab in the Programs panel.
2. Choose New from the File menu, and choose Folder.
3. Enter the group name you want. The new group's icon appears in the group window.



Opening a nested group
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
In a program window, a nested group has its own icon. On a menu for a Programs panel tab, a nested group appears 
as an item in the menu.

To open a nested group from a program group window
1. Open a group by double-clicking its tab in the Programs panel.
2. Double-click the icon for the nested group.

The nested group opens in its program window.

To open a nested group from the Programs panel
1. Display the group's menu by clicking its tab in the Programs panel.

A downward-facing arrow in the menu indicates a nested group
2. Click the menu item containing the nested group name and downward-facing arrow.

The menu for the nested group appears, with an upward-facing arrow indicating a "parent" group.
3. Click the nested group name.

The nested group opens in its program window.



Moving or copying a program between groups
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also

To move a program
1. Open both group windows by double-clicking their tabs in the Programs panel.
2. Drag the program item icon from one window to the other.

To copy a program
1. Open both group windows by double-clicking their tabs in the Programs panel.
2. Hold the Ctrl key while dragging the program item icon from one window to the other.



Changing a group's name or colour key
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
You can change a program group's description or colour key. The change is automatically reflected in the Windows 
95 Programs menu.

To change a program group
1. Click  to open the Customise dialog box.

2. Click Programs to display preferences for the Programs panel.
3. In the Program Groups list, click the group you want to modify.
4. Click Modify.
5. Enter a new description, or select a colour setting as described in Modify Program Group dialog box.

The description and colour you specify will appear on the group's tab in the Programs panel.



Refreshing group information
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
If you make changes in Windows 95 that do not appear in your Dashboard program groups, you can refresh the 
program group information by doing one of the following:

Click Reread Groups From System in the Customise dialog box.
Right-click the Programs panel and choose Reread Groups from the shortcut menu.
Exit Dashboard and restart it.



The Taskbar
{button ,AL(`TASKBAR')} See also
The Dashboard Taskbar provides some features not available with the Windows 95 taskbar.

In addition to being able to dock the taskbar at any side of the screen, the Dashboard Taskbar can "float" 
anywhere within the window you choose to place it.

You can right-click an icon in the Dashboard Taskbar and choose Task Info to see information about that 
application.

The Dashboard Taskbar can display labelled or unlabeled icons.
The Taskbar displays all running programs as buttons. Clicking a program's button switches to that program. The 
Taskbar can attach to the Dashboard, float as a snapped-off palette, or dock to the left, right, top, or bottom of your 
screen.
Each time you start a program, Dashboard automatically adds it to the Taskbar. When you close a program, 
Dashboard removes it from the Taskbar.
For information on using the Taskbar, click See also or click >> to browse through the topics.



Opening, closing, and hiding the Taskbar
{button ,AL(`TASKBAR')} See also

To open the Taskbar
Click 

To close the Taskbar
Click the Close box on the upper left corner of the snapped-off Taskbar.

To hide the Taskbar
1. Click  to open the Customise dialog box.

2. Click Taskbar to display preferences for the Taskbar.
3. Click Hide Item.
When the Taskbar is hidden, the list on the left indicates that the panel is "not shown." To restore the Taskbar, click 
Show Item.



Using the Taskbar's shortcut menu
{button ,AL(`TASKBAR')} See also
The Taskbar's shortcut menu differs depending on what you right-click in the Taskbar: a program in the Taskbar, the 
edge of the Taskbar, or the Dashboard program button in the Taskbar.

Program button
When you right-click a program button, the shortcut menu has these program-oriented options:

Minimise, Maximise, or Restore (depending on the state of the selected application)
Task Info
Close

Edge of the Taskbar
When you right-click the edge of the Taskbar, the shortcut menu has these options related to the position and 
performance of the Taskbar:

Left
Right
Top
Bottom
Floating
Disable (or Enable) Auto Hide

Note: If the Taskbar is docked at one side of the screen, you can find the Taskbar's edge by moving your mouse to
that side of the screen. Right-clicking there will be on the Taskbar's edge.

Dashboard button in the Taskbar
When you right-click the Dashboard program button in the Taskbar, the shortcut menu has options related to 
Dashboard itself.



Snapping the Taskbar on and off
{button ,AL(`TASKBAR_APPEARANCE')} See also
You can snap off the Taskbar and display it as a floating palette. You use the Taskbar in the same way whether it is 
on Dashboard or snapped off.

To snap off the Taskbar
Do any of the following:

Click 

Right-click the Taskbar and choose Snap Off from the shortcut menu.

To snap on the Taskbar
Do any of the following:

Click 

Right-click the snapped-off Taskbar and choose Snap On from the shortcut menu.



Docking the Taskbar to the edge of your screen
{button ,AL(`TASKBAR_APPEARANCE')} See also
You can dock the Taskbar to any edge of your screen.

To dock the Taskbar
Do any of the following:

Right-click a blank portion of the snapped-off Taskbar and choose Left, Right, Top, or Bottom from the 
shortcut menu.

In the Customise dialog box, click one of the following:
Snap to Top Edge
Snap to Left Edge
Snap to Bottom Edge
Snap to Right Edge



Auto-hiding the Taskbar
{button ,AL(`TASKBAR_APPEARANCE')} See also
You can auto-hide the Taskbar, which means it is hidden until you move the mouse over it.
For example, if the Taskbar is docked at the bottom of the screen, it is hidden until you move the mouse pointer to 
the bottom of the screen. The Taskbar then appears and remains visible until you move the mouse away from it.

To auto-hide the Taskbar
Do any of the following:

Right-click a blank portion of the snapped-off Taskbar and choose Enable Auto Hide.
In the Customise dialog box, choose Auto Hide.



Specifying labels and icons for the Taskbar
{button ,AL(`TASKBAR_APPEARANCE')} See also
You can specify whether the programs on the Taskbar display labels or icons. Labelled buttons show the names of 
the currently open programs and the files.

To specify labels for the Taskbar
In the Customise dialog box, choose Labelled.

To specify icons for the Taskbar
In the Customise dialog box, choose Show Icons in Buttons.



colour key
The coloured corner on a Program panel tab.



configuration
The appearance and behaviour of Dashboard; all your preferences and settings. You can 
customise the configuration of every panel in Dashboard, and of Dashboard itself.
You can create and save as many Dashboard configurations as you want. For example, you can 
create separate configurations called HOME.CFG and OFFICE.CFG that set Dashboard up for 
different purposes.



Dashboard Run
A dialog box containing both a command line and a DOS command window from which you can
execute DOS commands to search directories, copy files, and launch programs.
To use Dashboard Run, click .



Extended Screen
One of several representations of full-screen views. Using Dashboard's Extended Screens is like 
connecting your computer to several side-by-side monitors. You can open programs on the 
Extended Screens and then switch back and forth among them to work with the different 
programs.



GDI resources
Graphic Device Interface resources; one of the two key components of Windows system 
resources. Windows uses GDI memory for graphics operations, such as drawing bitmaps, lines, 
and fill patterns. Windows reserves 64k of memory for GDI resources.
See also Windows system resources, user resources



hotkey sequence
A key sequence that activates Dashboard, an Extended Screen, Dashboard Run, or a program.
When defining a hotkey sequence, you can use several types of keys:

Function keys F1-F9 and F11-F24 (if you have them)
Modifying keys (such as Alt, Shift, and Ctrl)
ASCII keys
Arrow keys

Choose a sequence that is unique and easy to remember.
Note:To avoid hotkey conflicts, Dashboard might redefine your sequence slightly. For 

example, if you type Ctrl+S (which is the Windows standard for saving a file), Dashboard
records the key sequence as Ctrl+Alt+S. When you type the key sequence, Dashboard 
displays the substituted sequence.



layout
The arrangement of program windows in the Extended Screens. A layout is like a freeze-frame 
picture of Dashboard at a specific moment. You can save layouts, which then appear on the 
Layout menu.
To work with layouts, click  to display the Layout menu.



shell
The program that opens when you run Windows; closing the shell closes Windows.



snooze interval
The number of minutes after which the alarm reappears when you click the Snooze button in an 
alarm message.



sticky app
A program that is displayed in every Extended Screen. When you designate programs as sticky 
apps, they are always displayed, regardless of which Extended Screen you are viewing.



total memory
The total amount of memory available on your computer, including Windows system memory 
and other memory not allocated to Windows.



user resources
One of the two key components of Windows system resources. Windows uses user memory for 
non-graphics features, such as text, menus, and window frames. Windows reserves 64k of 
memory for user resources.
See also Windows system resources, GDI resources.



Windows shell
See shell.



Windows system resources
The portion of memory reserved by Windows for its own operation. The two key components of 
system resources GDI resources and user resources
each reserve 64K of memory.
Every Windows application you open uses up some of the GDI resources and user resources. If 
you have too many applications open, the available level of system resources becomes too low to
launch any new Windows applications. If you are unable to launch a new application, or the 
Resources panel indicates that your system resources are too low for the application you want to 
launch, you can increase the level of available system resources by closing one or more of your 
currently running applications.
See also user resources, GDI resources



working directory
When you want to work with data files in a different directory than the program you use to create
those files, you specify a Working Directory in the Customise dialog box. When you launch the 
program, the current directory will be the working directory. Here's an example: Your word 
processing program, Word for Windows, is in a directory named WINWORD, but you've 
specified a working directory named MEMOS. When you run Word and use the Open command,
you'll see MEMOS displayed as the working directory in the Open File dialog box.



About button
{button ,AL(`BUTTONS')} See also

The About button  shows information about Dashboard, including the product number, product 
version number, and copyright information.



Run button
{button ,AL(`BUTTONS')} See also

The Run button  displays the Dashboard Run dialog box, which performs DOS commands and 
launches programs.



Customise button
{button ,AL(`BUTTONS')} See also

The Customise button  opens the Customise dialog box, which customises and sets the preferences 
for all the Dashboard panels.

For example, you can use the Customise dialog box to:
Change the positions of items on Dashboard
Choose whether to show or hide particular items
Specify the fonts and colours to be used on the Dashboard
Set hotkeys and mouse buttons to toggle Dashboard in front of and behind other windows
Save specific configurations of Dashboard in files and load them as needed



Help button
{button ,AL(`BUTTONS')} See also

Use the Help button  to find the help you need:
Click the Help button to display the question mark cursor. Place the question mark over any item 

on the Dashboard and click to see help for that specific item.
Double-click the Help button to see the help contents. Click a topic to see the instructions you 

want, or click the Index button to locate a particular word or phrase.



Maximise button
{button ,AL(`BUTTONS')} See also

The Maximise button  extends Dashboard horizontally to its full width.
When you click the Maximise button, any expandable panels grow and use more space in Dashboard. 
Expandable panels display scroll arrows to indicate items that are not currently shown. If none of the 
current Dashboard panels are expandable, Dashboard does not change its size.
Use the restore button  to return Dashboard to its previous width.



Minimise button
{button ,AL(`BUTTONS')} See also

The Minimise button  minimises Dashboard into the Taskbar.
Click the Dashboard button in the Taskbar to restore Dashboard.



Restore button
{button ,AL(`BUTTONS')} See also

The Restore button  restores the previous size of the Dashboard, after you have maximised it with 
the Maximise button.



Close button
{button ,AL(`BUTTONS')} See also

The Close button  closes Dashboard.



Snap-off controls
{button ,AL(`BUTTONS')} See also

The Snap-off controls are buttons that snap panels on or off the Dashboard:

Snaps the Program Panel on or off
Snaps the Quick Launch panel on or off
Snaps the Printers panel on or off
Snaps the Taskbar on or off

A triangle in the button indicates the current state of each panel:
A triangle in the upper-right corner of the button indicates that the panel is snapped off

separated from the Dashboard.
A triangle in the lower-left corner of the button indicates that the panel is snapped on

attached to the Dashboard.
If a panel is hidden, clicking its Snap-off button displays the panel, in addition to snapping it on or off.
Right-clicking the button displays a shortcut menu that lets you customise the panel.



Layout button
{button ,AL(`BUTTONS')} See also

The Layout button  displays the Layout menu, which names, saves, and loads custom layouts or edits 
existing layouts. When you save a layout, Dashboard saves all the programs currently running, as well
as their size and position on the extended screens.



System menu
{button ,AL(`MENUS')} See also

The System menu  includes standard Windows System menu commands for working with the 
window, as well as Dashboard commands to switch to other Dashboard menus.



Task menu
{button ,AL(`MENUS')} See also

The Task menu  switches among currently open programs.
You can also use the Task menu to display an open program on the current extended screen, run new 
programs, and close all programs other than Dashboard and DOS applications.
You can synchronise your extended screens to correspond to the currently open program windows by 
using the Update Screens command on the Task menu.



Title bar
The title bar displays the Dashboard title, and it can also show the current date and time or information
about your system resources. Click and drag the title bar to move the entire Dashboard.



Sizing bar
The sizing bar surrounds the Dashboard and is used to resize the Dashboard.
The pointer becomes a two-headed arrow when you position it over the sizing bar. Drag to change the 
width or height of the Dashboard.
Resizing Dashboard may prevent some panels from displaying all their items. When this happens, 
panels on the left or on the top have priority over panels on the right or on the bottom.
For example, if the Quick Launch panel is to the left of the Printers panel, more Quick Launch buttons 
than printers are visible. You can use the scroll arrows to see the other printers, or you can resize the 
printer panel by holding down the Shift key and dragging the panel borders.



Add Sticky App dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_STICKY')} See also
Makes a running application into a sticky app.
To display the Add Sticky App dialog box, click Add on the Sticky Apps page.

Using Add Sticky App

Select a Sticky App to Add
Displays a list of running applications. Select the application that you want to designate as a sticky app, then click 
OK.



Alarm Settings dialog box
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also
Specifies settings for an alarm, such as how and when the alarm sounds.
To display the Alarm Settings dialog box, click Add in the Clock Alarms dialog box.

Using Alarm Settings

Alarm Text
Specifies the text that appears with the alarm message.

Time
Specifies the time when the alarm sounds.

Alarm Date
Specifies whether the alarm sounds on a specific date or recurs each week.

Recurring specifies an alarm that occurs at the same time on the same day each week. Choose Recurring, 
then choose the day of the week for the alarm to sound.

Date specifies an alarm that occurs on a specific date. Choose Date, then enter the date for the alarm to 
sound.

Application
Specifies information about a program that optionally runs when the alarm goes off.

Program
Specifies the path and name of the program you want to run when the alarm goes off.

Directory
Specifies the working directory for the program that runs when the alarm goes off.

Run Minimised
Runs the specified program minimised.

Browse
Lets you browse to enter the name and path of the program you want to run.

Chime
Specifies the type of sound that occurs when the alarm goes off.

Play Chime
Plays the sound you have selected in the Chime field.



Application Task Information dialog box
Displays information about the memory used by the selected application in the Task Manager.
To display the Application Task Information dialog box, select an application in the Task Manager and choose Task 
Info.



Browse dialog box
Lets you navigate to locate a file.
To display the Browse dialog box, click the Browse button in another dialog box.

Using Browse

Look In
Specifies the folder that contains the file you are looking for.

File Name
Specifies the name of the file you are looking for. Click the file name in the list or type it here.

Files of Type
Specifies the type of files that appear in the list.

Open
Enters the name of the selected file in the dialog box that opened the Browse dialog box.



Change Icon dialog box (Printers panel)
{button ,AL(`PRINTER_PANEL;PRINTER_PANEL_CONFIGURING')} See also
Changes the icon Dashboard uses in the Printers panel for the selected printer.
To display the Change Icon dialog box, click Change Icon on the Printers page.

Using Change Icon

Current Icon
Specifies the icon used in the Printers panel by the selected printer.



Change Icon dialog box (Quick Launch Preferences)
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also
Changes the icon Dashboard uses for an application in the Quick Launch panel.
To display the Change Icon dialog box, click Icon on the Applications page.

Using Change Icon

File Name
Specifies the name and path of the file that contains the icon you want to use. Changing the file here will not change 
the file used to launch this program.

Current Icon
Specifies the icon Dashboard uses for the selected application.

Browse
Lets you browse to enter the name and path of the file that contains the icon you want to use.



Clock Alarms dialog box
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also
Displays the alarms you have set, and lets you add, edit, and delete alarms.
To display the Clock Alarms dialog box, do one of the following:

Click a date on the calendar.
Right-click the Clock/Calendar panel and choose Alarms.
Double-click the clock.

Using Clock Alarms

Alarms
Lists alarms you have already set.

Add
Adds an alarm. Click Add to open the Alarm Settings dialog box.

Edit
Changes an existing alarm. Select an alarm in the Alarms list, then click Edit to open the Alarm Settings dialog box.

Delete
Deletes an existing alarm. Select an alarm in the Alarms list, then click Delete to remove it.

Snooze Interval
Specifies the amount of time that elapses between the first alarm and the reminder.

Disable Alarms
Temporarily disables all alarms without deleting them.



Dashboard Run dialog box
{button ,AL(`DASH_RUN')} See also
Performs DOS commands and launches programs.
To display the Dashboard Run dialog box, click  on the Dashboard.

Using Dashboard Run

Command Line
Specifies a command or program to run. Type the name of the command or program, or choose it from the drop-
down history list.

Run
Runs the command or program displayed in the Command Line box.

Run Minimised
Minimises the window that contains the running command or program.

Done
Closes the Dashboard Run dialog box.

Browse
Lets you browse to enter the name and path of the program you want to run.



Dashboard Task Manager
Lets you manage applications in the following ways:

Switch between currently running applications.
Close a running application.
Tile or cascade currently running applications.
Display memory usage information about a running application.

Using Dashboard Task Manager

Task List
Displays a list of currently running applications that are not minimised.

Minimised Applications
Displays a list of currently running applications that are minimised.

Switch To
Switches to the selected application.

Task Info
Displays information about the selected application.

Close Selected
Closes the selected application.

Tile
Tiles applications in the Task List.

Cascade
Cascades applications in the Task List.



Edit Layout dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also
Changes the preferences of a program used in a layout, including the file name, working directory, and so on.
Dashboard saves the information displayed in this dialog box automatically when you create a layout. You can use 
the Edit Layout dialog box to change this information. Dashboard uses this new information to run programs when 
you use the Load Layout command.
To display the Edit Layout dialog box, select a program and click Edit in the Save Layout dialog box or the Manage 
Layouts dialog box.

Using Edit Layout

Application Name
Specifies a name for the program. This is a descriptive name, not a file name.

Command Line
Specifies the file name of the program.

Working Directory
Specifies the working directory used by the program.

Parameters
Specifies any command line parameters needed to run the program. For example, if you want a file to open when the
program launches, enter the file path and name here.

Window Size
Specifies the initial display size of the window containing the program.



Layout Icon dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also
Specifies an icon for a layout. The icon appears on the Quick Launch panel in the Layouts group.
To display the Layout Icon dialog box, click Icon in the Manage Layouts dialog box.

Using Layout Icon

Current Icon
Specifies the icon used in the Quick Launch panel by the selected layout.



Load Configuration File dialog box
{button ,AL(`TASKS_GLOBAL;CONFIGURATIONS')} See also
Loads a configuration file for Dashboard to use. The configuration file controls the appearance of programs and 
panels on the Dashboard. By default, the configuration file used by Dashboard is DEFAULT.CFG.
To display the Load Configuration File dialog box, choose Load from the File menu in the Customise dialog box.

Using Load Configuration File

Look In
Specifies the folder that contains the configuration file you are looking for.

File Name
Specifies the name of the configuration file you are looking for. Click the file name in the list or type it here.

Files of Type
Specifies the type of files that appear in the list.

Open
Loads the selected configuration file and changes the appearance of Dashboard.



Manage Layouts dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also
Lets you delete and rename layouts, and delete and edit the preferences of programs used in the layout.
To display the Manage Layouts dialog box, choose Manage Layouts from the Layout menu: 

Using Manage Layouts

Layout
Displays the layouts you have already created.

Delete
Deletes the selected layout. Select the layout you want to delete in the Layout list, then click Delete.

Rename
Renames the selected layout. Select the layout you want to rename in the Layout list, then click Rename to display 
the Rename Layout dialog box.

Icon
Specifies the icon to use when the layout is displayed on the Layouts group of the Quick Launch panel. For 
information on displaying this group, see Viewing layouts on the Quick Launch panel.

Load Selected Layout on Startup
Specifies whether to load the selected layout when Dashboard starts.

Applications
Displays applications used in the selected layout.

Delete
Removes the selected application from the selected layout. Select a layout in the Layout list, select the application 
you want to delete in the Applications list, then click Delete.

Edit
Changes the preferences of the selected application in the selected layout. Select a layout in the Layout list, select 
the application you want to edit in the Applications list, then click Edit to display the Edit Layout dialog box.

Save Changes
Saves any changes to the layout and closes the dialog box.



Modify Program Group dialog box
{button ,AL(`PROGRAM_PANEL_APPEARANCE')} See also
Changes the group name, file name, and colour associated with a Dashboard program group.
To display the Modify Program Group dialog box, select a program group on the Program Groups page, then click 
Modify.

Using Modify Program Group

Group Description
Specifies the name of the group displayed by the Programs panel.

Colour Key
Specifies the colour associated with the program group.
A colour key is useful for sorting different categories of program groups. For example, you can make all word 
processors the same colour.



New Program Group dialog box
{button ,AL(`PROGRAM_PANEL_GROUPS')} See also
Creates a Dashboard program group.
To display the New Program Group dialog box, click New from the Program Groups page.

Using New Program Group

Group Description
Specifies the name of the group displayed by the Programs panel.

Colour Key
Specifies the colour associated with the program group.



Resources dialog box
{button ,AL(`RESOURCES')} See also
Contains information about your memory, Windows system resources, and your system environment. Use the 
Resources dialog box to examine resource usage and to set alarm levels for low resources.
To display the Resources dialog box, do one of the following:

Double-click the Resources panel.
Right-click the Resources panel and choose Details.

Using Resources

Select Item to View
Lists the types of resources and system information that Dashboard monitors. Select an item in the list to display 
information about it.

Memory and Resources
System Environment
Drive Usage
Applications Running
Environment Variables

Print
Prints the information you are viewing in the Resources dialog box.



Memory and Resources
{button ,AL(`RESOURCES_GAUGE')} See also
Displays statistics about memory and Windows system resources, and lets you set alarms to warn you about 
declining resources.
To display this information, click Memory and Resources in the Select Item to View list in the Resources dialog box.

Using Memory and Resources

System Memory
Displays the total memory, the used memory, and the free memory in kilobytes and as a percent of total memory.

GDI System Resources
Displays the total GDI resources, the used GDI resources, and the free GDI resources in kilobytes and as a percent 
of the total.

User System Resources
Displays the total user resources, the used user resources, and the free user resources in kilobytes and as a percent of 
the total.

Alarm
Sounds an alarm to warn you when memory or resources reach a specific level.

K Free sounds an alarm when the total free memory for your computer drops to this level. Enter an amount 
in kilobytes as the alarm threshold.

% Free sounds an alarm when the either the GDI or User system resources for your computer drop to this 
level. Enter the percentage of free resources as the alarm threshold.

Play Sound
Plays the selected sound. Choose a sound for the alarm, then click Play Sound to preview the sound.

Display System Memory Odometer
When the gauge type is a fuel gauge or a bar gauge, displays the system memory as an odometer on the Resources 
panel.

Display System Resources Gauge
Controls the display of the system resources gauge on the Resources panel.

Gauge Type
Specifies the type of system resources gauge that Dashboard uses on the Resources panel.



System Environment
{button ,AL(`RESOURCES')} See also
Displays information about the system environment, such as CPU type, monitor type, mouse, keyboard, network, 
output port, and output devices installed under Windows.
To display this information, click System Environment in the Select Item to View list in the Resources dialog box.



Drive Usage
{button ,AL(`RESOURCES')} See also
Displays statistics about your disk drives, such as total disk space, used disk space, and available disk space. The 
information includes floppy drives, hard disk drives, and network drives.
To display this information, click Drive Usage in the Select Item to View list in the Resources dialog box.

Using Drive Usage

Drive
Displays the list of available floppy drives, hard disk drives, and network drives.

Total
Displays the total amount of disk space on each drive in megabytes.

Used
Displays the amount of used disk space on each drive in megabytes.

Free
Displays the amount of free disk space on each drive in megabytes.

% Free
Displays the percent of free disk space on each drive.

Add/Remove
Adds or removes a drive from the list of drives displayed in the Resources panel. Select a drive in the list, then click 
Add to add it to the Resources panel, or click Remove to remove it from the Resources panel.

Update Interval
Specifies the time interval, in seconds, between updates to the drive usage information on the Resources panel.

Display Drive Watch Window
Specifies whether to display the drive usage information in the Resources panel.

Refresh
Refreshes the displayed drive usage information.



Applications Running
{button ,AL(`RESOURCES')} See also
Displays a list of currently running applications and their memory usage. The list is sorted according to the amount 
of memory used by each application.
To display this information, click Applications Running in the Select Item to View list in the Resources dialog box.

Using Applications Running

Refresh
Refreshes the displayed application and memory information.

Close Application
Closes the selected application. Select an application in the list, then click Close Application.



Environment Variables
{button ,AL(`RESOURCES')} See also
Displays information about environment variables.
To display this information, click Environment Variables in the Select Item to View list in the Resources dialog box.



Save Configuration File dialog box
{button ,AL(`TASKS_GLOBAL;CONFIGURATIONS')} See also
Creates a configuration by saving a configuration file with a new name.
To open the Save Configuration File dialog box, choose Save As from the File menu in the Customise dialog box.

Using Save Configuration File

Save In
Specifies a folder to contain the file you want to save.

File Name
Specifies the name of the file you are saving.

Save as Type
Specifies the type of files that appear in the list.

Save
Saves the configuration file.



Save Layout dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also
Lets you save the programs currently running as a Dashboard layout.
To display the Save Layout dialog box, choose Save Layout from the Layout menu: 

Using Save Layout

Enter a Name for this Layout
Specifies the name of the layout. If you accept the default name, "Default", the layout is named "Default".

Load Layout on Startup
Specifies whether to load the layout when Dashboard starts.
If you check this option, you can still start Dashboard without loading the layout. Hold down the Shift key when you
double-click the Dashboard icon. Dashboard will not launch the startup layout.

Programs for this Layout
Displays the programs used in the layout you are saving.

Edit
Changes the preferences of the programs used in the layout you are saving. Select a program in the Programs for this
Layout list, then click Edit to display the Edit Layout dialog box.

Delete
Removes the selected application from the layout you are saving. Select a program in the Programs for this Layout 
list, then click Delete.



Customise dialog box
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also
Use the Customise dialog box to specify your Dashboard preferences. You can customise the appearance and 
behaviour of every panel in Dashboard, and of Dashboard itself.
To open the Customise dialog box, do one of the following:

Right-click the Dashboard and choose Customise.
Click 

Panels
The Customise dialog box lets you specify your preferences for the following panels, and for Dashboard itself:

Dashboard
Quick Launch panel
Win Tools panel
Resources panel
Clock/Calendar panel
Printers panel
Extended screens panel
Games panel
Programs panel
Taskbar



Dashboard page
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Sets preferences that control the overall appearance and behaviour of Dashboard.
To display the Dashboard page, select Dashboard in the scrolling list in the Customise dialog box, then click the 
Dashboard tab.

Using Dashboard

Dashboard Always in Front
Displays Dashboard in front of any other windows. When this option is not checked, you must activate Dashboard to
bring it to the front.

Replace Windows Task Manager
Lets you manage running programs with the Dashboard Task Manager instead of the Windows Task Manager.

Show Icons in Menus and Screens
Displays program icons in Extended Screens, Programs panel menus, and the Task menu.

Attach to System Tray
When checked, minimising Dashboard causes it to appear as an icon in the system tray of the Windows 95 Taskbar.

Title Bar Display
Specifies the appearance of the Dashboard title bar.

Standard displays the title only.
Clock/Calendar displays the date, time, and title.
Resources displays system resource information and the title.

Dashboard Orientation
Specifies the orientation of the Dashboard.
You move and size Dashboard the same way whether it is displayed vertically or horizontally. If you resize the 
vertical Dashboard, some panels adjust to fit in the space you've defined. For example, the Extended Screens panel 
might not display the screen selectors if there is not enough room. In this case, double-click the screens themselves 
to switch back and forth, or adjust the size of Dashboard by dragging its edges.



Hotkeys page (Dashboard panel)
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Sets hotkeys for Dashboard, the Explorer, and the Dashboard Run dialog box.
To display the Hotkeys page, select Dashboard in the scrolling list in the Customise dialog box, then click the 
Hotkeys tab.

About hotkeys
When you use the hockey or the mouse shortcut for Dashboard, Dashboard is displayed in front of all other 
windows. If Dashboard is already in front, the hockey or the mouse shortcut sends it to the back. The hotkeys for the
Explorer and Dashboard Run display the Explorer and Dashboard Run in front of all other windows.
To clear the existing hockey, press Del or Backspace.

Using Hotkeys

Dashboard
Specifies a key or key combination to use as a hockey for Dashboard.

Windows Explorer
Specifies a key or key combination to use as a hockey for the Explorer.

Dashboard Run
Specifies a key or key combination to use as a hockey for the Dashboard Run dialog box.

Mouse Hockey
Specifies a mouse button combination to use as a shortcut for Dashboard. A mouse shortcut can be a combination of 
any modifying key (Alt, Shift, or Ctrl) and the mouse buttons.



Appearance page
{button ,AL(`TASKS_GLOBAL;DASH_PREFS;DASH_PREFS_APPEARANCE')} See also

Sets preferences for the font and colour scheme used in Dashboard.
To display the Appearance page, select Dashboard in the scrolling list in the Customise dialog box, then click the 
Appearance tab.

Using Appearance

Face Name
Specifies the type face of the font used in Dashboard. This list shows the fonts currently installed on your system.

Size
Specifies the size of the font used in Dashboard.
Depending on the font, the smallest point size available is 6 points; the largest is 12 points. The Dashboard resizes 
according to the font.

Style
Specifies the type style of the font used in Dashboard. Choose a style, such as Bold or Italic (when available for the 
selected font).

Colour Scheme
Specifies the colour used as the background on the Dashboard.

Use Windows Colours
Uses the default colours.

Reset Defaults
Restores the default colour scheme and font used by Dashboard.



Snap Off page
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Creates snapped-off panels and sets preferences that control their appearance and behaviour.
To display the Snap Off page, select Dashboard in the scrolling list in the Customise dialog box, then click the Snap 
Off tab.

Using Snap Off

Programs
Check to snap off the Programs panel.

Quick Launch
Check to snap off the Quick Launch panel.

Printers
Check to snap off the Printers panel.

Taskbar
Check to snap off the Dashboard Taskbar.

Panels minimise with Dashboard
Check to minimise snapped-off panels when Dashboard is minimised.

Enable ToolTips
Check to display a brief description in a ToolTip help bubble when the cursor pauses above an icon or button.



Panels page
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Adds and removes panels from Dashboard. When you remove a panel in this dialog box, you remove it from display
and memory. For information on removing a panel from display but keeping it in memory, see Hiding Panels.
To display the Panels page, select Dashboard in the scrolling list in the Customise dialog box, then click the Panels 
tab.

To add a panel
1. Select the panel in Available Panels.
2. Click Add.

To remove a panel from display and memory
1. Select the panel in Panels in Use.
2. Click Remove.

Using Panels

Available Panels
Displays panels that are removed from Dashboard.

Add
Adds the selected panel in the Available Panels list to the Dashboard display.

Remove
Removes the selected panel in the Panels in Use list from the Dashboard display and from memory.

Panels In Use
Displays panels that are in use in Dashboard.



Applications page
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also

Adds and removes applications from Quick Launch groups.
To display the Applications page, select Quick Launch in the scrolling list in the Customise dialog box, then click 
the Applications tab.

Using Applications

Applications
Lists the applications in the selected Quick Launch group.

Groups
Lists the available Quick Launch groups.

New
Adds an application to the selected Quick Launch group. Select the group in the Groups list, click New, then enter 
information about the new program in the Application Settings panel.

Delete
Deletes the selected application from the selected Quick Launch group. Select the group in the Groups list, select the
application to remove, then click Delete.

Title
Specifies the name of the program. This is a descriptive name, not a file name.

Command
Specifies the path and file name of the program. If you don't know the path name for the program, click Browse.

Directory
Specifies the working directory used by the program.

Shortcut Key
Specifies a key or key combination to use as a hockey.
To clear the existing Shortcut Key, press Del or Backspace.
If you use this hockey when you have a full-screen DOS application running, Dashboard will not launch the 
application associated with the hockey. If the application is already running, Dashboard will bring the window to the
front of the desktop.

Run Minimised
Minimises the window that contains the running program.

Icon
Specifies an icon for the program item. If you don't specify an icon, Dashboard provides one.

Browse
Lets you browse to enter the name and path of the program.



Groups page
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_GROUPS')} See also

Adds and removes Quick Launch groups.
To display the Groups page, select Quick Launch in the scrolling list in the Customise dialog box, then click the 
Groups tab.

Using Groups

Applications
Lists the applications in the selected Quick Launch group.

Groups
Lists the available Quick Launch groups.

New
Creates a Quick Launch group. Click New, then enter information about the new program group in the Group 
Settings section.

Delete
Deletes the selected Quick Launch group. Select a group in the Groups list, then click Delete.

Name
Specifies the name of the selected Quick Launch group.

Desktop Tab
Displays the Desktop Quick Launch group that Dashboard provides. This group contains all icons and shortcuts 
found on your Windows 95 desktop.

Documents Tab
Displays the Documents Quick Launch group that Dashboard provides. This group contains the 15 documents you 
have accessed most recently. These are the same as the documents found on your Start menu Documents folder.

Layouts Tab
Displays the Layouts Quick Launch group that Dashboard provides. This group contains all layouts you have 
defined. If you create a layout with three applications, for example, a single click on the icon in this group launches 
all three applications and positions them on your extended screens.



Launch Bar page
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_APPEARANCE')} See also

Specifies the type of buttons displayed in the Quick Launch panel.
To display the Launch Bar page, select Quick Launch in the scrolling list in the Customise dialog box, then click the 
Launch Bar tab.

Using Launch Bar

Position
Specifies the location of the snapped-off Launch Bar. If the Launch Bar is currently snapped on, it appears in the 
position you specify as soon as it is snapped off.

Auto Hide
Hides the Launch Bar until you move the mouse pointer over it.
For example, if the Launch Bar is attached to the side of your screen, it remains hidden until you move your mouse 
pointer to that edge. Then the Launch Bar appears and remains visible until you move your pointer away from it.

Always in Front
Keeps the Launch Bar in front of other windows, even when another other window is active. If you maximise a 
program when the Launch Bar is set to Always in Front, the program resizes to the edge of the Launch Bar without 
covering it.



Options page (Quick Launch panel)
{button ,AL(`QUICK_LAUNCH')} See also

Specifies the type of buttons displayed in the Quick Launch panel.
To display the Options page, select Quick Launch in the scrolling list in the Customise dialog box, then click the 
Options tab.

Using Options

Button Style
Specifies the type of button that appears in the Quick Launch groups:

Unlabeled displays only icons on the buttons.
Labelled displays icons and application names on the buttons.
Mini displays miniature buttons with icons.

Sort Groups
Sorts your Quick Launch groups. Choose one of the following options, then click Sort Groups.

Alphabetically sorts the groups alphabetically.
By Personal Preference sorts the most recently used to the start of the list, immediately following the three 

system groups.

Re-Synchronise
Updates the three system Quick Launch groups (Desktop, Documents, and Layouts) to reflect any changes you have 
made in, for example, shortcuts on the desktop. It also runs the App Organizer, which scans for known applications 
and puts them into one of the pre-defined Quick Launch groups.



Win Tools panel
{button ,AL(`WIN_TOOLS')} See also

Assigns Windows 95 programs to each button on the Win Tools panel.

Using Win Tools panel preferences

Tool 1-4
For each tool, select a program from the drop-down list.



Memory page
{button ,AL(`RESOURCES')} See also
Displays statistics about memory and Windows system resources, and lets you set alarms to warn you about 
declining resources.
To display the Memory page, select Resources panel in the scrolling list in the Customise dialog box, then click the 
Memory tab.

Using Memory

System Memory
Displays the total memory, the used memory, and the free memory in kilobytes and as a percent of total memory.

GDI System Resources
Displays the total GDI resources, the used GDI resources, and the free GDI resources in kilobytes and as a percent 
of the total.

User System Resources
Displays the total user resources, the used user resources, and the free user resources in kilobytes and as a percent of 
the total.

Alarm
Sounds an alarm to warn you when memory or resources reach a specific level.

K Free sounds an alarm when the total free memory for your computer drops to this level. Enter an amount 
in kilobytes as the alarm threshold.

% Free sounds an alarm when the either the GDI or User system resources for your computer drop to this 
level. Enter the percentage of free resources as the alarm threshold.

Play Sound
Plays the selected sound. Choose a sound for the alarm, then click Play Sound to preview the sound.

Display System Memory Odometer
When the gauge type is a fuel gauge or a bar gauge, displays the system memory as an odometer on the Resources 
panel.

Display System Resources Gauge
Controls the display of the system resources gauge on the Resources panel.

Gauge Type
Specifies the type of system resources gauge that Dashboard uses on the Resources panel.



Drives page
{button ,AL(`RESOURCES_DRIVES')} See also
Displays statistics about your disk drives, such as total disk space, used disk space, and available disk space. The 
information includes floppy drives, hard disk drives, and network drives.
To display the Drives page, select Resources panel in the scrolling list in the Customise dialog box, then click the 
Drives tab.

Using Drives

Drive
Displays the list of available floppy drives, hard disk drives, and network drives.

Total
Displays the total amount of disk space on each drive in megabytes.

Used
Displays the amount of used disk space on each drive in megabytes.

Free
Displays the amount of free disk space on each drive in megabytes.

% Free
Displays the percent of free disk space on each drive.

Add/Remove
Adds or removes a drive from the list of drives displayed in the Resources panel. Select a drive in the list, then click 
Add to add it to the Resources panel, or click Remove to remove it from the Resources panel.

Update Interval
Specifies the time interval, in seconds, between updates to the drive usage information on the Resources panel.

Display Drive Watch Window
Specifies whether to display the drive usage information in the Resources panel.

Refresh
Refreshes the displayed drive usage information.



Clock page
{button ,AL(`CLOCK_CALENDAR')} See also

Customises the appearance of the clock.
To display the Clock page, select the Clock/Calendar panel in the scrolling list in the Customise dialog box, then 
click the Clock tab.

Using Clock

Clock Type
Specifies the type of clock to display on the Clock/Calendar panel.

Analogue shows the minute and hour hands pointing to numbers on the clock face.
Digital represents the time as a number.

Clock Face
Lists the types of faces available for analogue clocks, and the colours available for digital clocks.

Show Second Hand
Specifies whether to display a second hand on an analogue clock.

Note: The second hand may interfere with some communication programs. If your communication program is 
experiencing unnecessary time-outs, try hiding the second hand.

Show Clock
Specifies whether to display or hide the clock on the Clock/Calendar panel.



Calendar page
{button ,AL(`CLOCK_CALENDAR')} See also

Customises the appearance of the calendar.
To display the Calendar page, select the Clock/Calendar panel in the scrolling list in the Customise dialog box, then 
click the Calendar tab.

Using Calendar

No Highlights
Specifies whether the calendar displays highlights for the current day and days with alarms.

Current Day
Specifies the colour of the highlight used to indicate the current day on the calendar.

Days with Alarms
Specifies the colour of the highlight used to indicate a day with alarms set on the calendar.

Show Calendar
Specifies whether to display or hide the calendar on the Clock/Calendar panel.

Go to Today
Returns the calendar to the current day. Use this if you are working with dates in another month, and you want to 
return to the current day quickly.

Change Date/Time
Lets you change the system date and time by opening the Windows Date/Time Properties dialog box.



Alarms page
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also

Adds, deletes, and changes alarms.
To display the Alarms page, select the Clock/Calendar panel in the scrolling list in the Customise dialog box, then 
click the Alarms tab.

Using Alarms

Alarms
Lists the alarms that are currently set.

Add
Creates an alarm. Click Add to display the Alarm Settings dialog box.

Edit
Modifies the selected alarm. Select an alarm in the Alarms list and click Edit to display the Alarm Settings dialog 
box.

Delete
Deletes the selected alarm. Select an alarm in the Alarms list and click Delete to remove it.

Snooze Interval
Specifies the amount of time that elapses between the first alarm and the reminder.

Disable Alarms
Temporarily disables all alarms without deleting them.



Printers page
{button ,AL(`PRINTER_PANEL;PRINTER_PANEL_CONFIGURING')} See also

Sets preferences for your printers.
To display the Printers page, select Printers in the scrolling list in the Customise dialog box, then click the Printers 
tab.

Using Printers

Default Printer
Displays the name of the default printer.

Choose a Printer to Configure or Reorder
Lists the printers currently specified in your system. Printers are displayed in the order in which they appear on the 
Printers panel. Drag to change the order of printers.

Hide Printer
Removes the selected printer from the display in the Printers panel. Select a printer in the list, then click Hide 
Printer.

Description
Specifies a description of the printer to be displayed in the Printers panel.

Set As Default
Specifies the selected printer as the default printer. Select a printer, then click Set As Default.

Setup
Sets up a printer in Windows. Click Setup, then refer to your Windows documentation for information about setting 
up the printer.

Change Icon
Click to select an icon for the printer. If you don't specify an icon, Dashboard provides one.



Options page (Printers panel)
{button ,AL(`PRINTER_PANEL')} See also

Controls whether paper orientation is displayed in the Printers panel.
To display the Options page, select Printers in the scrolling list in the Customise dialog box, then click the Options 
tab.

Using Options

Default Printer
Displays the name of the default printer.

Show Paper Orientation
Shows the paper orientation in the icon on the Printers panel.



Screens page
{button ,AL(`EXT_SCREENS;EXT_SCREENS_APPEARANCE')} See also

Sets preferences for the appearance and behaviour of Extended Screens.
To display the Screens page, select Extended Screens in the scrolling list in the Customise dialog box, then click the 
Screens tab.

Using Screens

Number of Screens
Specifies the number of Extended Screens displayed on the Extended Screens panel.

Display
Specifies whether the Extended Screens are displayed in full size or compact form on the Extended Screens panel.

Background
Specifies a background to use for Extended Screens on the Extended Screens panel.

Predefined specifies that the Extended Screens background is one of the default backgrounds provided with
Dashboard.

Use Windows Background specifies that the Extended Screens background is the same as the Windows 
background.

Bitmap specifies that the Extended Screens background is a bitmap. Enter the name of the bitmap or 
browse for it.

Browse
Lets you browse to enter the name and path of the bitmap to use as an Extended Screen background.



Hotkeys (Extended Screens panel)
{button ,AL(`EXT_SCREENS')} See also

Specifies the hotkeys used for the Extended Screens.
To display the Hotkeys page, select Extended Screens in the scrolling list in the Customise dialog box, then click the
Hotkeys tab.

Using Hotkeys

Screen #
Displays the number of the Extended Screen.

Type Here to Define Screen Hotkeys
Specifies a key or key combination to use as a hockey.
To clear the existing hockey, press Del or Backspace.



Sticky Apps page
{button ,AL(`EXT_SCREENS;EXT_SCREENS_STICKY')} See also

Creates a sticky app for the Extended Screens.
To display the Sticky Apps page, select Extended Screens in the scrolling list in the Customise dialog box, then click
the Sticky Apps tab.

Using Sticky Apps

Add
Makes the selected program a sticky app.

Delete
Removes the selected program from the list of sticky apps.



Games panel
{button ,AL(`GAMES')} See also

Specifies the type of game displayed in the Games panel and the size of the default bet, and scrambles the slide 
puzzle.

Using Games panel preferences

Game Type
Specifies the type of game displayed in the Games panel.

Video Poker
Slot Machine
Slide Puzzle

Default Bet
Specifies the amount of the default bet.

Reset Money
Resets the amount of money you are playing with to $200.

Scramble Puzzle
Rearranges the pieces of the slide puzzle.



Program Groups page
{button ,AL(`PROGRAM_PANEL;PROGRAM_PANEL_GROUPS')} See also

Rearranges Dashboard program groups and modifies, opens, creates, removes, and hides program groups.
To display the Program Groups page, select Programs in the scrolling list in the Customise dialog box, then click the
Program Groups tab.

Using Program Groups

Program Groups
Displays a list of Dashboard program groups. Program groups are displayed in the order in which they appear on the
Programs panel. Drag to change the order of program groups.

Modify
Modifies the selected program group. Select a group in the Program Groups list, then click Modify to open the 
Modify Program Group dialog box.

Open
Opens the selected program group. Select a group in the Program Groups list, then click Open to display it.

Delete
Deletes the selected program group. Select a group in the Program Groups list, then click Delete to remove it.

New
Creates a program group. Click Create to display the New Program Group dialog box.

Hide Group/Show Group
Hides or displays the selected program group. Select a group in the Program Groups list, then click Hide 
Group/Show Group to hide or display it.



Options page (Programs panel)
{button ,AL(`PROGRAM_PANEL;PROGRAM_PANEL_APPEARANCE')} See also

Sets preferences for the tabs used on the Programs panel.
To display the Options page, select Programs in the scrolling list in the Customise dialog box, then click the Options
tab.

Using Options

Tall Buttons
Controls the size of the tabs on the Programs panel. Check to display two lines of text on each tab.

Show Colour Keys
Determines whether a colour key appears on each tab on the Programs panel. Check to display a colour key.
A colour key is useful for sorting different categories of program groups. For example, you can make all word 
processors the same colour. Set up colour keys in the Modify Program Group dialog box.

Sort Alphabetically
Sorts the tabs on the Programs panel alphabetically.

Sort by Colour
Sorts the tabs on the Programs panel by colour key.

Reread Groups from System
Updates Dashboard with changes you have made in Windows 95. See Refreshing group information.



Taskbar page
{button ,AL(`TASKBAR;TASKBAR_APPEARANCE')} See also

Sets preferences for the Taskbar.
To display the Taskbar page, select Taskbar in the scrolling list in the Customise dialog box, then click the Taskbar 
tab.

Using Taskbar

Position
Specifies the location of the snapped-off Taskbar. If the Taskbar is currently snapped on, it appears in the position 
you specify as soon as it is snapped off.

Auto Hide
Hides the Taskbar until you move the mouse pointer over it.
For example, if the Taskbar is attached to the side of your screen, it remains hidden until you move your mouse 
pointer to that edge. Then the Taskbar appears and remains visible until you move your pointer away from it.

Always in Front
Keeps the Taskbar in front of other windows, even when another other window is active. If you maximise a program
when the Taskbar is set to Always in Front, the program resizes to the edge of the Taskbar without covering it.



Settings page
{button ,AL(`TASKBAR;TASKBAR_APPEARANCE')} See also

Sets preferences for buttons used in the Taskbar.
To display the Settings page, select Taskbar in the scrolling list in the Customise dialog box, then click the Settings 
tab.

Using Settings

Button Style
Specifies whether an icon for a running program appears with a label when you view it in the Taskbar. The label 
includes the name of the program and the file that is open.

Hide Ionised Applications
Hides the icons of programs that are minimised. The icons are still available in the Taskbar.
This option applies only if you are running a Windows shell such as Program Manager.

Show Icons in Buttons
Specifies whether to display an icon for each program in the Taskbar, along with its description.



attrib
Displays or sets the attributes (read-only, archive, system, hidden) of files.
Syntax
attrib [+r|-r] [+a|-a] [+s|-s] [+h|-h ] [[drive:][path]filename] [/s]



call
Transfers control from one batch file to another until that batch file ends, returning control to the 
first batch file.
Syntax
call [drive:][path]filename [batch-parameters]



cd (chdir)
Changes the directory or displays the name of the current directory.
Syntax
cd [drive:] [path]
cd[..]
chdir [drive:] [path]
chdir[..]



cls
Clears the screen and the command line, as well as removing all previous output from the output 
window.
Syntax
cls



copy
Copies a file from one location to another or combines files.
Syntax
copy [/a|/b] source [/a|/b] [+source[/a|/b] [+ ...]] [destination [/a |/b]] [/v]



date
Changes the system date.
Syntax
date [month-day-year]



del (erase)
Erases a file or group of files.
Syntax
del [drive:] [path] filename [/p] [/s]
erase [drive:] [path] filename [/p] [/s]



dir
Lists the files and subdirectories in a directory.
Syntax
dir [drive:] [path] [filename] [/p] [/w] [/a[[:]attributes]] [/o[[:]sortorder]] [/s] [/b] [/l]



echo
Determines whether commands are displayed as they are executed from the command prompt or 
from a batch file.
Syntax
echo [off|on]
echo [message]



edit
Opens the specified text file in the Windows WordPad application.
Syntax
edit [[drive:][path]filename] 



exit
Closes the Dashboard Run dialog box.
Syntax
exit



find
Searches for a string of characters or numbers within a specified file or files.
Syntax
find [/v] [/c] [/n] [/i] "string" [[drive:][path]filename]



for
Allows you to perform a command on a set of files.
Syntax
When used in a batch file:
for %%variable in set do command [command-parameters]
When used at the command prompt:
for %variable in set do command [command-parameters]



goto
Transfers execution in a batch program to a specified line, rather than the next line in the batch 
program.
Syntax
goto label



help
Loads the help system.
Syntax
help [<command name>]



if
Tests whether a condition is true before carrying out a command. (If the condition is false, the 
specified command is not executed.)
Syntax
if [not] errorlevel number command
if [not] string1==string2 command
if [not] exist filename command



label
Displays or changes the volume label assigned to a floppy disk or hard drive.
Syntax
label [drive:] [label]



md (mkdir)
Creates a subdirectory on the specified drive.
Syntax
md [drive:]path
mkdir [drive:]path



path
Determines where to look for executable files (.EXE, .COM, .BAT, AND .PIF) and documents.
Syntax
path
path [=] [[drive:][path][;...]]



pause
Suspends execution of a batch file until the user presses a key or clicks a mouse button.
Syntax
pause



print
Allows you to print a file to the current printer.
Syntax
print [[drive:][path]filename[...]]



prompt
Determines how the command prompt is displayed.
Syntax
prompt [text]



rd (rmdir)
Removes the directory specified by <dirname>.
Syntax
rd [drive:][path]
rmdir [drive:][path]



rem
Precedes comments in batch files.
Syntax
rem [comment]



ren (rename)
Renames files or directories.
Syntax
ren [drive:][path] filename1|directoryname1 filename2|directoryname2
rename [drive:][path] filename1|directoryname1 filename2|directoryname2



set
Displays, sets, or deletes DOS environment variables.
Syntax
set [variable=[string]]



shift
Allows a user to specify more than ten parameters on the command prompt for a batch file by 
replacing the contents of the first parameter (%0) with the contents of the second (%1) and 
shifting each subsequent parameter down in similar fashion.



sort
Sorts input and writes the output to a device or file.
Syntax
sort [/r] [/+n] [<] [drive1:][path1]filename1 [>[drive2:][path2]filename2]
[command|]sort [/r] [/+n] [>[drive2:][path2]filename2]



time
Displays or sets the system time.
Syntax
time [hh:mm]ss:[.xx]][a|p]]



type
Displays the contents of an ASCII text file within the Windows Prompt Edit Control output 
windows.
Syntax
type [drive:][path]filename



ver
Displays the version of your operating system and the version of Windows Prompt Edit Control.
Syntax
ver



vol
Displays the label and serial number assigned to a drive.    If no drive is specified, the current 
drive is used.
Syntax
vol [drive:]



xcopy
Copies files, using all memory made available by Microsoft Windows.
Syntax
xcopy source [destination] [/a|/m] [/d:date] [/p] [/s [/e]] [/w]




